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Customer Support  
Customer Support hours 

Customer Support is available 7x24x365 via email, phone, and Web access.  

Depending on the Support option chosen by a particular client (Standard, Plus, or Premium), the 
times that certain services are delivered may be restricted. Severity 1 (Critical) issues are 
addressed on a 7x24 basis and receive continuous attention until resolved, for all clients on active 
maintenance. Retek customers on active maintenance agreements may contact a global Customer 
Support representative in accordance with contract terms in one of the following ways. 

Contact Method Contact Information 

E-mail     support@retek.com 

Internet (ROCS)  rocs.retek.com 
     Retek’s secure client Web site to update and view issues 

Phone    +1 612 587 5800 

Toll free alternatives are also available in various regions of the world: 

Australia   +1 800 555 923 (AU-Telstra) or +1 800 000 562 (AU-Optus) 
France    0800 90 91 66 
Hong Kong   800 96 4262 
Korea    00 308 13 1342 
United Kingdom 0800 917 2863 
United States  +1 800 61 RETEK or 800 617 3835 

Mail     Retek Customer Support 
     Retek on the Mall 
     950 Nicollet Mall 
     Minneapolis, MN 55403 

When contacting Customer Support, please provide: 

• Product version and program/module name. 

• Functional and technical description of the problem (include business impact). 

• Detailed step-by-step instructions to recreate. 

• Exact error message received. 

• Screen shots of each step you take. 

 

http://rocs.retek.com/
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Chapter 1 - Introduction 
The RPAS configuration tools provide a flexible means to configure and build RPAS-based 
applications with customer-specific business parameters.  

The configuration tools consist of an integrated set of task-specific configuration “aids” that can 
be used to configure a solution from scratch, or to use an existing solution configuration template 
as a basis from which to make customer-specific changes. RPAS functionality is exposed via 
API’s to the configuration tools, which provide a streamlined and user-friendly interface to utilize 
RPAS functionality. Once configured, an installer script is used to build an RPAS domain for the 
configured solution. 

This document describes how to use the RPAS configuration tools and how to build an RPAS 
domain. 

Concepts 
The core of the RPAS configuration tools is the configuration manager. The configuration 
manager provides an overall view of the configuration components (projects and solutions, which 
contain hierarchies, measures, rules, workbook templates, and wizards). 

An RPAS configuration represents the overall workspace. For example, you could create a 
workspace called XYZ for customer XYZ. Within configuration XYZ, you create a project. Each 
project represents an RPAS domain.  

For a project, you create hierarchies and dimensions within those hierarchies. Hierarchies are the 
structures used by an organization to describe the relationships that exist between the dimensions 
that comprise a hierarchy. For a project, the following hierarchies are automatically created: 
Calendar, Product, Location, and ADMU. You create and define dimensions for these hierarchies, 
and for any additional hierarchies that you create. 

For a project, you can also specify data interfaces for measures (that is, the data files from which 
measure data will be imported). 

A project contains one or more solutions, which corresponds to an application configuration (for 
example, Financial Planning or Item Planning). For each solution, you define measures, rules, 
workbooks, and, optionally, wizards. 

Measures are any item of data that can be represented on a grid in a worksheet (in other words, 
they are multidimensional variables). Measures are the data points that are used in the customer’s 
business process. 

Rules are collections of expressions that describe the relationships between measures. 
Expressions are the basis of all calculations of the relationships between measures, and are 
evaluated by the calculation engine during a calculation. Expressions are written in a syntax that 
allows for the calculation of a single measure from other measures, constants and parameters, 
using standard arithmetical functions and a rich set of mathematical, technical and business 
functions. Expressions are therefore an algorithmic statement of a relationship between measures. 
All the expressions in a rule must use the same measures; that is, all inverses of a rule must be 
defined in expressions for that rule. They must also have a different target measure (that is, the 
measure on the left hand side of the expression that is calculated by the expression). 
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A workbook is the easily viewed, easily manipulated multidimensional framework used to 
perform specific business functions such as creating a merchandise plan and reviewing 
availability data. To present data, a workbook can contain any number of multidimensional 
spreadsheets, called worksheets, as well as measures that are used on the worksheets and the rules 
that are used to generate the measure data. All of these components work together to facilitate 
viewing and analysis of business functions. The configuration tools allow you to configure 
workbook templates incorporating these various components. 

A wizard is a feature that steps the user through the process of building a new workbook. A 
wizard displays successive dialogs that require the user to answer a sequence of questions or enter 
selections regarding the content of the workbook. Responses to these questions are used to 
automatically format and populate the workbook. The configuration tools allow you to create 
custom wizard formats. 

Configuration Steps 
Follow these steps to create an RPAS configuration.  

 Set up system properties and source control. See Chapter 3 – System properties and source 
control. 

 Create a configuration. See Working with configurations. 

 Create a project. See Working with projects. 

 Create solutions. See Working with solutions. 

 Create hierarchies and dimensions. See Working with hierarchies and Working with 
dimensions. 

 Create measure components and measures. See Working with components and Working with 
measures. 

 Create rule sets, rule groups, and rules. See Working with rule sets, Working with rule 
groups, and Working with rules. 

 Create workbooks, workbook tabs, and worksheets. See Working with workbooks, Working 
with workbook tabs, and Working with worksheets. 

 Create wizards. See Working with wizards. 

 Define data import information. See Using the Data Interface Tool. 

 Build an RPAS domain. See Chapter 12 – Building an RPAS domain.  
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Chapter 2- Using menus and toolbars 
This section contains descriptions of the menu and toolbar options available from the RPAS 
configuration tools interface. 

Application main menu bar 
The menu bar and the items contained in each menu are context-sensitive, and change according 
to what you are working on and how you are working. Menu items that are grayed out are not 
available to you in your current work mode.  

The menu bar displays the following options: 

• File 

• Window 

• Utilities 

• Automation 

• Help 

Menu shortcuts 
You can also access menus by pressing the Alt key followed by the underlined letter for the menu 
item. For example, <Alt+F> accesses the File menu. Some menu items have shortcut key 
combinations; those that do have the key combination displayed next to the menu item name. For 
example, <Ctrl+N> accesses the New file dialog box. In addition to key combinations, some 
menu items can be directly accessed from toolbar buttons.  

In addition, standard Windows shortcuts are included in the tools, although they may not appear 
on a menu. Examples are Ctrl+V (copy) and Ctrl+C (paste). 

File menu 
File > New 

Allows you to select from the following: 

• Configuration 

• Project 

• Solution 

 Note: Depending on what already exists in your configuration, not all of the above 
options may be selectable. For example, you cannot select Solution until you have 
created a project for your configuration.  

File > Open 

Displays a dialog box that allows you to access all the configurations that you have created and 
saved. To open a configuration, highlight the selection you want to view and click Open. 

File > Source Control 

Allows you to check configurations into and out of a CVS repository, so that more than one 
person can work on a configuration at the same time. You can select from the following options: 
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• Import Configuration 

• Synchronize Configuration 

• Add Configuration 

File > Close 

The Close menu item is only available when a configuration is open. If the configuration has been 
previously saved and no new changes have been made, selecting Close closes the workbook. 

File > Save 

Stores all the information in the configuration. If the configuration you are working on has 
previously been saved, then selection of this menu item will update the stored information. If the 
configuration has not been previously saved, then selection of this menu item will open the Save 
As dialog box, which will prompt you for a configuration name. The Save menu item is only 
enabled when a workbook has been created or opened. 

File > Save As 

Opens a dialog box in which you can specify the name of the configuration to be saved. The Save 
As menu item is only enabled when a configuration is open. 

In the Configuration text field of the Save As dialog, type a name for the configuration.   

Selecting the “Use Defaults” check box saves the configuration in the default location. This 
location defaults to the last location you saved to. If the “Use Defaults” check box is not checked, 
you can specify a directory in which to save the configuration. If the directory does not exist, it 
will be created. Alternately, you can click Browse to select a directory in which to save the 
configuration. 

Click OK to save the configuration, or click Cancel to return to the configuration without saving. 

File > Preference 

The General tab allows you to specify how many items to display in the Most Recently Used 
(MRU) list, to specify measure content validation, and to set up source control. 

File > Workspace Properties  

Allows the user to specify if the configuration will be used for Global Domain, Hypersparse, or 
Multilanguage purposes. You can also view the configuration language that was specified when 
the configuration was initially created. You cannot change the language after the configuration 
has been created. 

File > MRU (Most Recently Used) List 

The MRU (Most Recently Used) List is located just above the Exit option on the File menu. The 
MRU List is a list of the most recently opened configurations. When a configuration is displayed 
on the MRU List, it can be accessed quickly by selecting that configuration directly from the File 
menu. 

If you open a configuration that already exists and save it under a new name by selecting Save As 
from the File menu, then both the old and the new configuration names will appear on the MRU 
List.  

File > Exit 

The Exit option logs you off of the application and exits the system completely. 
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If you have an unsaved configuration open at the time you select Exit, the Close dialog box will 
be opened, informing you that modifications have been made to the configuration. 

Window 
The Window menu allows you to navigate quickly through your open configurations. This 
provides an alternative to using the tree structure in the Configuration Manager window. 

Window > Configuration > Hierarchies 

Opens the Hierarchy Definition window for the configuration you select. See Hierarchies for 
more information. 

Window > Configuration > Data Interface 

Opens the Data Interface window for the configuration you select. See Using the Data Interface 
Tools for more information. 

Window > Configuration > Solution > Measures 

Opens the Measure Definition window for the solution you select. See Measures for more 
information. 

Window > Configuration > Solution > Rules 

Opens the Rule Definition window for the solution you select. See Rules for more information. 

Window > Configuration > Solution > Workbooks 

Opens the Workbook Designer window for the solution you select. See Workbooks for more 
information. 

Window > Configuration > Solution > Wizard Designer 

Opens the Wizard Designer window for the solution you select. See Wizards for more 
information. 

Help 
Help > Contents 

Displays the Table of Contents for the online help system.  

Help > Index 

Displays an index of the terms found in the online help system. 

Help > Search 

Use this function to search the online help system for a word or phrase. 

Quick (right-click) menus 
In various areas throughout the application, context-sensitive quick menus, also called right-click 
menus, are available to access certain commands. To access a quick menu, place the cursor over 
an appropriate screen area and click the right mouse button. These quick menus are context-
sensitive; that is, their availability, appearance, and the options they offer differ depending on 
your current mode of work. 

There are other uses for quick menus, as well, depending on your mode of work.  The following 
is a description of the various right-click menus you may encounter: 



Retek Predictive Application Server 
 

6 

• Configuration Manager quick menu – Obtained when you right-click over the left frame of 
the Configuration Manager window. Use this menu to create new configurations, projects, 
and solutions. You can also use it to open, save, rename, clone, and close existing 
configurations, projects and solutions.  

• Hierarchy Definition quick menu – Obtained when you right-click over the Hierarchy 
window. Use this menu to create, delete, and rename hierarchies and dimensions. 

• Measure quick menus include the Measure Definition menu, and menus for the Components 
tab, Measures tab, and Realized Measures tab. Use these menus to create, rename, and delete 
components and measures; realize and unrealize measures; specify measure attributes; push 
components down and pull components up; and show and hide measures. 

• Rule quick menus include the Rule definition menu and the Rules menu. Use these menus to 
add, rename, and delete rules, rule groups, and rule sets; add expressions to rules; edit 
expressions; and generate load and commit rules. 

• Wizard Designer menu – Obtained when you right-click over the Wizard Designer window. 
Use this menu to delete and copy wizards and wizard pages. 

Configuration Manager quick menu 
New > Configuration 

Creates a new configuration. 

New > Project 

Creates a new project within the selected configuration. 

New > Solution 

Creates a new solution within the selected project. 

Open 

Displays the Open dialog box, from which you can select a configuration to open. 

Close 

Closes the current configuration. If you have made any changes and have not yet saved them, the 
Save dialog box is displayed, allowing you to save your changes before closing the configuration. 

Close All 

Closes all open configurations. For each configuration you have changed and have not yet saved, 
the Save dialog box is displayed, allowing you to save your changes before closing the 
configuration. 

Save 

Saves any changes you have made to the selected configuration. 

Save As 

Opens the Save As dialog box, allowing you to save the selected configuration under another 
name. 

Save All 

Saves changes you have made to all open configurations. 
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Rename 

Opens the Rename dialog box, allowing you to specify a new name for the selected object. 

Clone 

Opens the Clone dialog box, allowing you to create an exact duplicate of the selected object. 

Move 

Opens the Move dialog box, allowing you to move the selected object from one location to 
another. 

Delete 

Allows you to delete a project or solution, with a delete confirmation message. The user cannot 
delete a configuration, however. 

Hierarchy Definition quick menu 
The following options are available on the Hierarchy Definition quick menu: 

New Hierarchy 

Creates a new hierarchy in the Hierarchy Definition window. By default, the hierarchy is assigned 
a name starting with H followed by the next available number (for example, H59). 

New Dimension 

Creates a new dimension within the selected hierarchy. By default, the dimension is assigned a 
name starting with D followed by the next available number (for example, D23). 

Rename 

Makes the name field editable, allowing you to change the name of the selected hierarchy object. 

Remove Selected Item 

Deletes the selected hierarchy object. 

Undo 

Reverses the last action. 

Redo 

Repeats the last action. 

Measure quick menu 
Measure Definition 

The following options are available on the Measure Definition quick menu: 

Add Major Component 

Adds a major component to the Measure Definition window. By default, the component is 
assigned a name starting with “component” followed by the next available number (for example, 
component1004). 
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Add Minor Component 

Adds a minor component underneath the selected component. By default, the component is 
assigned a name starting with “component” followed by the next available number (for example, 
component 1009). 

Pull Up 

Pulls the selected component up one level in the measure classification structure. 

 Note: You cannot pull up a major component. Nor can you pull up a minor component 
directly beneath a major component that is directly beneath a major component. 

Push Down 

Pushes the selected component down one level in the measure component structure. A new 
component is created to take the place of the component you are pushing down. By default, the 
new component is assigned a name starting with “component” followed by the next available 
number (for example, component1014). 

Show 

Shows the components and measures associated with the selected component on the Components 
and Measures tabs. A check in the box next to the component indicates that the measures are 
shown. 

Hide 

Hides the components and measures associated with the selected component. The components 
and measures are not displayed on the Components or Measures tabs. The box next to the 
component is unchecked. 

Show All 

Shows all components and measures for the solution on the Components and Measures tabs. The 
boxes next to all components are checked. 

Hide All 

Hides all components and measures for the solution. No components or measures are listed on the 
Components or Measures tabs, and the boxes next to all components are unchecked. 

Realize 

Realizes the selected measure, and checks the Realized box on the Measures tab. This option is 
available only if the measure is not already realized.  

Unrealize 

Unrealizes the selected measure, and unchecks the Realized box on the Measures tab. This option 
is available only if the measure is already realized.  

Rename 

Makes the name field editable, allowing you to change the name of the selected component. 

Edit Properties 

Highlights the properties for the selected measure so you can edit them. 

Delete 

Displays the Confirm Delete dialog, allowing you to delete the selected component. 
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Undo 

Reverses the last action. 

Redo 

Repeats the last action. 

Components tab 

The following options are available on the Components tab quick menu: 

Undo 

Reverses the last action. 

Redo 

Repeats the last action. 

Measures tab 

The following options are available on the Measures tab quick menu: 

Realize All 

Realizes all of the displayed measures. The box in the Realized column is checked for each 
measure. 

Unrealize All 

Unrealizes all of the displayed measures. The box in the Realized column is unchecked for each 
measure. 

Undo 

Reverses the last action. 

Redo 

Repeats the last action. 

Realized  Measures Tab 

Realize All 

Realizes all of the displayed measures. The box in the Realized column is checked for each 
measure. 

Unrealize All 

Unrealizes all of the displayed measures. The box in the Realized column is unchecked for each 
measure. 

Undo 

Reverses the last action. 

Redo 

Repeats the last action. 
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Rule quick menu 

Rule Definition 

The following options are available on the Rule Definition quick menu: 

Add > Rule Set 

Displays the Add Rule Set dialog, allowing you to add a rule set to the solution. 

Add > Rule Group 

Displays the Add Rule Group dialog, allowing you to add a rule group to the selected rule set. 

Add > Rule 

Displays the Add Rule dialog, allowing you to add a rule to the selected rule group. 

Rename > Rule Set 

Displays the Rename Rule Set dialog, allowing you to change the name and description of the 
selected rule set. 

Rename > Rule Group 

Displays the Rename Rule Group dialog, allowing you to change the name and description of the 
selected rule group. 

Delete > Rule Set 

Displays the Confirm Delete dialog, allowing you to delete the selected rule set. 

 Note: All rule groups within the rule set are also deleted. 

Delete > Rule Group 

Displays the Confirm Delete dialog, allowing you to delete the selected rule group. You cannot 
delete the load, commit, calc, and refresh rule groups. If you attempt to delete them, the Confirm 
Delete dialog is displayed, allowing you to empty the rule groups instead. 

 Note: All rules within the rule group are also deleted.  

Undo 

Reverses the last action. 

Redo 

Repeats the last action. 

Advanced > Generate Load Rules 

Auto generates rules in the load rule group, based on the measures contained in the calc rule 
group that also have a database defined in the measure tool. 

Advanced > Generate Commit Rules 

Auto generates rules in the commit rule group, based on the measures contained in the calc rule 
group. 

Rules 

The following options are available on the Rules quick menu: 
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Add > Rule 

Displays the Add Rule dialog, allowing you to add a rule to the selected rule group. 

Add > Expression 

Displays the Add Expression dialog, allowing you to add an expression to the selected rule. 

Rename Rule 

Displays the Rename Rule dialog, allowing you to change the name and description of the 
existing rule. 

Apply Pattern 

Displays the Apply Pattern dialog, allowing you to auto generate rules using the same rule pattern 
as the selected rule. 

Edit Expressions 

Displays the Edit Expression dialog, allowing you to add expressions to the rule and edit existing 
expressions. 

Delete > Rule 

Displays the Confirm Delete dialog, allowing you to delete the rule from the selected rule group. 

Undo 

Reverses the last action. 

Redo 

Repeats the last action. 

Wizard Designer quick menu 
The following options are available on the Wizard Designer quick menu: 

Copy Wizard 

Duplicates the selected wizard page. 

Delete Wizard 

Removes the selected wizard page. 

Copy Wizard Group 

Duplicates the selected wizard and all associated wizard pages. 

Delete Wizard Group 

Removes the selected wizard and all associated wizard pages. 

Paste 

Inserts whatever you most recently copied using either Copy Wizard or Copy Wizard Group. 
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Buttons 

Hierarchy Definition 

Hierarchy frame 

Move hierarchy up 

Moves the selected hierarchy up one position in the hierarchy table. Note that this indicates the 
hierarchy’s position in the data file only, and not the hierarchy. 

Move hierarchy down 

Moves the selected hierarchy down one position in the hierarchy table. Note that this indicates the 
hierarchy’s position in the data file only, and not the hierarchy. 

Dimension frame 

Move dimension up 

Moves the selected dimension up one position in the hierarchy data file only. The hierarchy 
structure itself does not change. Note that this indicates the dimension’s position in the data file 
only, and not the hierarchy. The start and labelstart fields change as do the dimensions before it, 
but the aggs field does not change. 

Move dimension down 

Moves the selected dimension down one position in the hierarchy data file only table. The 
hierarchy structure itself does not change. Note that this indicates the dimension’s position in the 
data file only, and not the hierarchy. The start and labelstart fields change as do the dimensions 
after it, but the aggs field does not change. 

Data Interface Manager 
New Meas 

Displays the New Measure Specification dialog, allowing you to specify the data interface for a 
measure. 

Delete Meas 

Displays the Confirm Delete dialog, allowing you to remove the measure from the list. 

Rule Definition 
Rule filtering 

Allows you to select one of four filters for displaying rules: 

• Disable Filtering – all rules are displayed. 

• Filter by Measure – filters by measures contained in the rule. 

• Filter by Size - Rules are filtered to show those with more than one expression. 

• Filter by Validity – only valid rules are displayed. 

Toggle the display of rule descriptions 

Allows you to display or hide rule descriptions. If you hide rule descriptions, only the rule name 
and associated measures are displayed in a shorthand format. 
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Workbook Designer 
Move selected Workbook Tab to the left 

Moves the selected workbook tab one position to the left. 

Move selected Workbook Tab to the right 

Moves the selected workbook tab one position to the right. 

Create a new workbook template 

Creates a new workbook template in the selected solution. 

Create a new workbook tab 

Creates a new workbook tab in the selected workbook. 

Create a new worksheet 

Creates a new worksheet in the selected workbook tab. 

Edit properties 

Displays the Properties dialog for the selected workbook, workbook tab, or worksheet. 

Delete workbook or workbook component 

Displays the Confirm Delete dialog, allowing you to delete the selected workbook, workbook tab, 
or worksheet. 

Undo last action 

Reverses the last action. 

Redo last action 

Repeats the last action. 

Cut to clipboard 

Cuts the selected object and places it on the clipboard. 

Copy to clipboard 

Copies the selected object and places it on the clipboard. 

Paste from clipboard 

Pastes the object from the clipboard into the workbook. 

Wizard Designer 
Create a new wizard 

Creates a new wizard in the selected solution. 

Create a new wizard page 

Creates a new wizard page in the selected wizard. 

Add a Label 

Adds a label to the selected wizard page. 

Add a Button 

Adds a button to the selected wizard page. 
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Add a radio button 

Adds a radio button to the selected wizard page. 

Add a check box 

Adds a check box to the selected wizard page. 

Add a combo box 

Adds a combo box to the selected wizard page. 

Add a text box 

Adds a text box to the selected wizard page. 

Toggle gridlines 

Displays or hides the gridlines on the selected wizard page. 

Finer gridlines 

Displays more closely spaced gridlines on the wizard page. 

Coarser gridlines 

Displays less closely spaced gridlines on the wizard page. 

Align left 

Aligns the control to the left. 

Center horizontally 

Centers the control horizontally. 

Align right 

Aligns the control to the right. 

Align top 

Aligns the control at the top. 

Center vertically 

Centers the control vertically. 

Align bottom 

Aligns the control at the bottom. 

Space horizontally 

Spaces the control horizontally. 

Space vertically 

Spaces the control vertically. 
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Chapter 3- System preferences and 
source control 
At the system level, you can set general preferences for the configuration tools. This section 
provides instructions for setting these general preferences. 

Preferences 
This section contains the following procedures: 

 Setting Workbench Preferences 

 Setting up Source Control 

Setting Workbench Preferences 
To set preferences for each workbench session: 

1. From the File menu, select Preferences. 

2. Click on the General tab.  

• Specify the number of configurations to be displayed in the Most Recently Used Entries 
(MRU) list. Use the up and down arrows to adjust the number.  

• If you want to turn on measure validation, check the Measure Content Realize box. 
Realization will be in effect for all open configurations if the box is marked. 

Source control 
The configuration tools are integrated with the CVS source control system, allowing multiple 
users to work on a configuration simultaneously, while maintaining data integrity. You must own 
a CVS license and have a CVS repository set up in order to use this feature. Refer to the CVS 
documentation for more information on setting up a repository and adding users. 

To use this feature, a “master” configuration is stored on a server in a CVS repository. At a 
minimum, the master configuration should contain a shell configuration consisting of hierarchies, 
measure class structure, rule sets, and workbook templates. Configuration users can then pull a 
copy of the configuration from the repository to their desktops. Changes can then made to this 
local copy. Users have the ability to synchronize their local copy of the configuration with the 
master copy that is stored on the server, by selecting changes to be updated on the server, or 
changes from the server to update their local copy. 

 IMPORTANT: While CVS features allow multiple users to work on a configuration 
simultaneously, external communication and coordination between configuration tools 
users must occur in order to avoid configuration data loss or corruption. The last change 
that is synchronized with the server is what wins. For example, suppose a user checks in a 
configuration after making changes to hierarchies. Shortly thereafter, another user checks 
in the same configuration after also making changes to hierarchies. The changes the 
second user made will overwrite the changes the first user made.  
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Setting up source control 
To set up source control: 

1. From the File menu, select Properties. 

2. Click on the Source Control tab. 

3. Type the following information: 

• User - Your CVS user ID. 

• Password - Your CVS password. 

• Server - The name of the machine hosting the CVS server. 

• Repository - The path to the CVS repository. 

4. Click OK to save your changes 

Adding a configuration 
To add a configuration to CVS: 

1. From the File menu, select Source Control, and then select Add Configuration. 

2. In the Workspace Name field, type the name of the configuration that you want to add to the 
repository. 

3. In the Workspace Directory field, type the name of the directory containing the configuration 
you want to add to the repository, or click the Browse button to select the directory. 

  Note: If you type or select the wrong directory, the message “Workspace does not exist” 
is displayed, and the OK button is deactivated. 

4. Click OK to add the configuration to the CVS repository. 

Importing a configuration 
To import a configuration from CVS: 

1. From the File menu, select Source Control, and then select Import Configuration. 

2. In the Workspace Name field, type the name of the configuration that you want to import 
from the CVS repository. 

 Note: You must type the name exactly as it was entered when it was added to the 
repository. 

3. In the Workspace Directory field, type the name of the directory on your local machine where 
you want to save the configuration, or click the Browse button to select the directory. 

4. Click OK to import the configuration from the CVS repository. 

Committing changes to a configuration 
To commit changes to a configuration in CVS: 

1. In the Configuration Manager window, select the configuration whose changes you want to 
commit. 

2. Save your configuration. See Saving a configuration in Chapter 4 for more information. 
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3. From the File menu, select Source Control, and then select Synchronize Configuration. 

4. In the Version Control Update window, select the changes that you want to commit to the 
repository. Eligible changes are identified by a right arrow ( ). To select more then one 
change at a time, press and hold the Ctrl key while selecting the changes. 

 Note: A double arrow ( ) indicates that a change has been made in the repository and 
on your local machine. You must decide how to proceed. You can commit your change, 
in which case the version in the repository will be overwritten. Alternately, you can 
update your local configuration with the latest changes from the repository, in which case 
the changes you made on your local machine will be overwritten. See Updating your 
local configuration for more information. 

5. Press the Commit button to save your changes to the repository. 

Updating your local configuration 
To update your local configuration with the latest changes from the repository: 

1. In the Configuration Manager window, select the configuration whose changes you want to 
commit. 

2. Save your configuration. See Saving a configuration in Chapter 4 for more information. 

3. From the File menu, select Source Control, and then select Synchronize Configuration. 

4. In the Version Control Update window, select the changes that you want to save to your local 
configuration. Eligible changes are identified by a left arrow ( ). To select more then one 
change at a time, press and hold the Ctrl key while selecting the changes. 

 Note: A double arrow ( ) indicates that a change has been made in the repository and 
on your local machine. You must decide how to proceed. You can update your local 
configuration with the latest changes from the repository, in which case the changes you 
made on your local machine will be overwritten. Alternately, you can commit your 
change, in which case the version in the repository will be overwritten. See Committing 
changes to a configuration for more information. 

5. Press the Update button to update your local configuration with the changes you selected. 

6. To see the updates from the repository, save your configuration, close it, and reopen it. 
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Chapter 4- Configuration Manager 
The configuration manager is the starting point for creating a new configuration, or opening an 
existing configuration. It provides a high-level view of all the components necessary to configure 
an RPAS application, and is used to navigate to the various tools used to configure those 
components. 

Working with configurations 
A configuration represents the overall workspace for the RPAS implementation. Each 
configuration contains a project, which in turn contains a project solution, which in turn contains 
one or more solutions.  

Creating a new configuration 
To create a new configuration: 

1. From the File menu (or via the right click menu), select New, and then select Configuration. 

2. Type the name of your new configuration in the text box. 

3. If you want to save the new configuration in the default directory, go to Step 5. Otherwise, 
uncheck the Use Defaults check box. 

4. Type the name of the directory in which to save the new configuration. Alternately, click 
Browse to choose a directory. 

5. Select the language that the configuration will be configured in from the drop-down list. This 
is the standard list that RPAS supports for translation purposes. 

 Note: The default language is English.  

6. Check the Global Domain box if the configuration will be used to create a global domain 
environment.  

7. Check the Hypersparse box if the configuration will be used in anticipation of creating a 
hypersparse domain. 

8. If you want the configuration to support multiple languages, check the MultiLanguage check 
box. 

9. Click OK to save the new configuration in the specified directory. 

 Note: Once you create and open the new configuration or open an existing configuration, 
you can view these settings under the File\Properties menu or from the Properties option 
on the context quick menu for the configuration. You can enable or disable global 
domain multiple language support at any time within the configuration. However, these 
properties are only used when an RPAS domain is first built. Changes made to these 
fields are ignored if you do a patch installation. You cannot change the language setting 
for a newly created or existing configuration. For more information, see Building an 
RPAS domain. 
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 Note: The patch process does support the hypersparse functionality. For example, for an 
existing sparse domain, if you check the hypersparse checkbox and run the patch process, 
the domain will automatically be converted to hypersparse. Similarly, vice versa, for an 
existing hypersparse domain, if you uncheck the hypersparse checkbox, then RPAS will 
automatically attempt to convert the domain to sparse during the patch process. 

Opening an existing configuration 
To open an existing configuration: 

1. From the File menu (or via the right click menu), select Open. 

2. Browse the directory structure until you locate the configuration you want to open. 

3. Click OK to open the selected configuration, or from the File menu, select a configuration 
from the displayed list of recently used configurations. 

Saving a configuration 
To save a configuration: 

1. From the File menu, select Save or Save As, as necessary. Any changes you have made to the 
configuration are saved to the specified directory path. Do not change the content of the 
configuration within Windows Explorer. 

Cloning a configuration 
You can create an exact copy of an existing configuration by cloning it. To clone a configuration: 

1. From the Configuration Manager right-click menu, select Clone. 

2. Type the new name for the configuration in the text box. 

3. Click OK to save the configuration under the new name. 

Renaming a configuration 
To rename a configuration: 

1. From the Configuration Manager right-click menu, select Rename. 

2. Type the new name for the configuration in the text box. 

3. Click OK to save the configuration under the new name. 

4. You must rename a configuration from within the Tools Workbench.  Do not rename the 
configuration folder using the Window Explorer. 

Working with projects 
A project corresponds to an RPAS domain. A configuration can have only one project. 

Creating a new project 
To create a new project: 

1. From the File Menu or Configuration Manager right-click menu, select New, and then select 
Project. 

2. Type the name of the new project in the text box. 
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3. Select the workspace (configuration) in which to create the new project. 

4. Click OK to create the new project in the specified workspace. 

Renaming a project 
To rename a project: 

1. Select the project that you want to rename. 

2. From the Configuration Manager right-click menu, select Rename. 

3. Type the new name for the project in the text box. 

4. Click OK to save the project under the new name. 

Moving a project 
You can move a project from one configuration to another. To move a project: 

1. Select the project that you want to move. 

2. From the Configuration Manager right-click menu, select Move. 

3. Type the name of the project in the text box. 

 Note: This is the name the project is called after it has been moved. 

4. Select the workspace (configuration) to which you want to move the project. 

5. Click OK to move the project to the specified workspace. 

Working with solutions 
A solution corresponds to an application configuration (for example, Merchandise Financial 
Planning or Item Planning). Each project can contain one or more solutions. For each solution, 
you define measures, rules, workbooks, and wizards. 

Cloning a solution 
You can create an exact copy of an existing configuration by cloning it. To clone a solution: 

1. Select the solution that you want to clone. 

2. From the Configuration Manager right-click menu, select Clone. 

3. Type the new name for the solution in the text box. 

4. Select the project in which to create the cloned solution. 

5. Click Finish to save the cloned solution in the specified project. 

Moving a solution 
You can move a solution from one project to another. To move a solution: 

1. Select the solution that you want to move. 

2. From the Configuration Manager right-click menu, select Move. 

3. Type the name of the solution in the text box. 

 Note: This is the name the solution is called after it has been moved. 
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4. Select the project to which you want to move the solution. 

5. Click Finish to move the solution to the specified project. 
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Chapter 5- Hierarchies 
The hierarchy definition tool allows you to define and construct hierarchies, dimensions within 
those hierarchies, and relationships between dimensions. 

When you create a project, the calendar, product, location, and ADMU hierarchies are 
automatically created by default. These hierarchies are required and cannot be deleted. 
 Additional hierarchies can be created as well. Dimensions for each of the hierarchies can then be 
defined. These hierarchies and dimensions are used for all solutions within the project. Therefore, 
two or more solutions can only be in the same project if they use the same hierarchy structure. 

Understanding hierarchies and dimensions 
 
Hierarchies are the structures that an organization uses to describe the relationships between and 
among the many dimensions. 

The following illustrates an example of a product hierarchy and the dimensions within that 
hierarchy.  

 

Dimensional level relationships in a product hierarchy 
SKU, style, and class are examples of specific dimensions that define the relationship between 
individual products. For this reason, SKU, style, and class are said to be dimensions of the 
product hierarchy.  

For example, consider an apparel manufacturer where shirts are one of the company’s many 
product classes. The following figure shows a possible relationship between dimensional levels in 
the company’s product hierarchy. 
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The items at the bottom of the hierarchy can be defined at their lowest level by SKU. Items at 
each successively higher level in the hierarchy contain the elements directly beneath; that is, 
lower level components in the hierarchy roll up (or aggregate) into higher ones. In this product 
hierarchy, shirts at the SKU level roll up into aggregate style/color groupings (for example, white 
crew-necks). Shirts at the style/color level can then be rolled up to the style level (for example, 
crew-necks); and styles can be rolled up into the product class level (for example, shirts). 

Dimensional level relationships in a location hierarchy 
This company can represent its hierarchy of locations in a similar fashion. In the following 
location hierarchy, stores are identified at their lowest level (the Store dimension) by city/store 
number. This hierarchical level rolls up into the state dimension, and the state level can be further 
aggregated into the region. 

 

Hierarchy rules (alternate hierarchies) 
Certainly, hierarchies can be much more complex than those in the examples. Note that an item at 
a particular level in a hierarchy can be rolled up along more than one hierarchical path (that is, an 
alternate hierarchy).  However, for any given path of rollup, that item can only belong to one 
parent at any higher dimensional level. For example, if a given store location is rolled up to the 
state level, it can only belong to one state position (for example, Georgia or Florida, but not both). 
You can view data at any level of detail you want by drilling down or rolling up through levels in 
the hierarchy. Hierarchies define the path of data aggregation and spreading. 

Working with hierarchies 
This section contains the following procedures: 

• Creating a new hierarchy 

• Specifying hierarchy information 

• Deleting a hierarchy 

• Renaming a hierarchy 

Creating a new hierarchy 
To create a new hierarchy: 

1. From the Hierarchy Definition right-click menu, select New Hierarchy. 

2. To change the name of the newly created hierarchy, click the hierarchy name twice and type 
the new name (or change the name in the hierarchy info table). 
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Specifying hierarchy information 
To specify hierarchy information: 

1. In the Hierarchy Definition window, click the name of the hierarchy for which you want to 
specify information or select it in the hierarchy info table. 

2. In the Hierarchy Info frame, type the following: 

• Name -- The RPAS internal name of the hierarchy. The hierarchy name can contain a 
maximum of four characters. 

• Label -- The hierarchy label that is displayed to RPAS users. 

• Purge Age – The number of days (without a load) before a position is purged from a 
dimension in this hierarchy. 

• Security Level – If position-level security is enabled in RPAS, the name of the dimension 
for which security should be enabled is specified here. 

• The Order column indicates the order in which the hierarchy information is expected in 
the file used for measure data loading purposes. The Order column indicates the order in 
which the hierarchy information is expected in the file used for data loading purposes. 
The order of the calendar hierarchy cannot be changed. It must always remain first in the 
order of the Product, Location, and ADMU hierarchies.  You can change the order of the 
Product and Location hierarchies. 

3. Use the up and down arrows to move the hierarchy to the desired location, therefore changing 
the Order hierarchy property. 

Deleting a hierarchy 
To delete a hierarchy: 

1. In the Hierarchy Definition window, select the hierarchy that you want to delete. 

2. From the Hierarchy Definition right-click menu, select Remove Selected Item, or use the 
button on the toolbar. 

3. You cannot delete the Calendar, Product, Location or ADMU hierarchies. 

Renaming a hierarchy 
To rename a hierarchy: 

1. In the Hierarchy Definition window, select the hierarchy that you want to rename. 

2. From the Hierarchy Definition right-click menu, select Rename (or just change it in the 
hierarchy info table). 

3. Type the new name for the hierarchy or. Click the hierarchy name twice, and then type the 
new name. 

 Note: Hierarchy names can contain a maximum of four characters. 
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Working with dimensions 
This section contains the following procedures: 

• Creating a new dimension 

• Specifying dimension information 

• Deleting a dimension 

• Renaming a dimension 

• Creating an alternate hierarchy 

Creating a new dimension 
To create a new dimension: 

1. From the Hierarchy Definition window, select the hierarchy or dimension under which to 
create the new dimension. 

2. From the Hierarchy Definition right-click menu, select New Dimension (you can also use the 
insert key). 

 Note: You can create only one top-level dimension per hierarchy. 

Specifying dimension information 
To specify dimension information: 

1. In the Hierarchy Definition window, select the dimension for which you want to specify 
information (or select the dimension in the Dimension Info table). 

2. In the Dimension Info frame, specify the following information, which are used during the 
data loading process: 

 RPAS Name - The RPAS internal name for the dimension. The dimension name can 
contain a maximum of four characters. 

 User Label - The dimension label that is displayed to RPAS users. 

 Column - identifies the column in the hierarchy load file. 

 Prefix - The Number of characters (0 to 4) for an automatic prefix to be put on all 
position names loaded and stripped from all position names exported. The prefix is taken 
from the internal dimension name. If the number of characters is greater than the 
dimension name, an underscore is used to pad the prefix. If the number of characters is 
less than the dimension name then the left-most characters from the dimension name are 
used. 

 Start - identifies the start position of the dimension name in the hierarchy load file. The 
field is calculated from entries in the width column. 

 Width - Width of position names for this dimension in the hierarchy load file. 

 Label Start - Identifies the start position for the label in the hierarchy load file. This files 
is calculated from entries in the label width column. 

 Label Width - Width of position labels for this dimension in the hierarchy load file. 

 Aggs - Identifies the dimension to which the selected dimension aggregates. This can be 
edited by using the drop down list. 
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 Database - The name of the database in which the dimension information is stored. 

 User Dimension -Indicates that the dimension is a user maintained dimension if the 
checkbox is marked. 

 Translate - Indicates that the dimension label is to be translated to a different language. 

Deleting a dimension 
To delete a dimension: 

1. In the Hierarchy Definition window, select the dimension that you want to delete of from the 
Hierarchy Definition right-click menu, select Remove Selected Item, or use the button on the 
toolbar. 

2. From the Hierarchy Definition right click menu, select Remove Selected Item, or use the 
button on the toolbar. 

Renaming a dimension 
To rename a dimension: 

1. In the Hierarchy Definition window, select the dimension that you want to rename. 

2. From the Hierarchy Definition right-click menu, select Rename. 

3. Type the new name for the dimension, or click the dimension name twice, and then type the 
new name.  

 Note: Dimension names can contain a maximum of four characters. 

Creating an alternate hierarchy 
To create an alternate hierarchy: 

1. In the Hierarchy Definition window, select the dimension from which you want to create an 
alternate hierarchy. 

2. From the Hierarchy Definition right-click menu, select New Dimension (you can also use the 
insert key). 

 





Chapter 6- Measures 
 

29 

Chapter 6- Measures 
The measure definition tool allows you to define components of measures and specify default 
properties for each component.  After you have defined the component structure, the measure 
definition tool generates prototype measures by combining the components you select. You can 
also specify properties for individual measures, thereby overriding the component default 
properties for those measures. 

Understanding measures and components 
A major component is the highest level in the class inheritance hierarchy. Properties defined at 
this level are inherited by all minor components created under a major component. 

Within each major component, you create one or more minor components. You can also create a 
minor component underneath a minor component. You can also modify properties at the minor 
component level.  

After you have defined your major and minor components, the measure definition tool generates 
prototype measures based on the combination of components you select. These prototype 
measures cannot be used elsewhere in the configuration tools until you have realized them. See 
Realizing and Unreal zing measures for more information. 

Component Process 
1. Create major components, from which measures are comprised. Examples: Role, Version, 

Metric, Unit of Measure, Level etc. 

2. Create minor components, which are sub-groupings or specific items in a major component. 

3. Define measure properties at the major component level. The minor components will inherit 
the properties associated with the major component they belong within. 

4. If necessary, modify the measure properties at the minor component level. 

Measure component design 
There are two basic principles to keep in mind to make the measure tool as powerful as possible. 

First, major and minor components should be designed with the idea of maximizing default 
properties. For example, if a configuration has 2000 measures, and 1500 of them are of data type 
real, every effort should be made to see that the property real is only explicitly set a minimal 
number of times at the minor component level, and not 1500 times at the actual measure level. 
Measures are the composition of minor components, and it is in those minor components that 
defaults should be set. 

The other major principle is to use minor components to make measure definition manageable. 
For example, in the previous paragraph, we established that we want to define the data type of 
real minimal number of times. Avoid grouping all 1500 measures into a single minor component, 
you cannot easily edit smaller subgroups of 1500 measures. Minor components can also have 
minor components, so within the 1500 measures, you could break them out further based on the 
aggregation method, such as total, max, recalc, etc. Ideally, the “checking” of a lowest level 
minor component should allow you to easily view and manage every resulting measure within 
that minor component. 
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Measure property Inheritance/over-writing defaults 
Measure properties are inherited at the component level. Properties defined for a component are 
spread down to all of the minor components that belong to that component and also to the 
measures associated with that component. Properties can then be over-written either at the minor 
component or measure level. Note that once a property is changed at the measure level, changes 
made at the component level will no longer be inherited by that measure. 

Measure Validation within the Measure Tool 
It is important to note that throughout the configuration tools, various types of validation take 
place. One place heavy validation occurs is in measures. The rule tool is heavily dependent on the 
measure tool for validation of the measures that are used in rules. For example, if a measure that 
is used in a rule is deleted in the measure tool, that rule becomes invalid. Because of this real time 
validation between the two tools, when working with a configuration with large measure and rule 
sets the validation performed in the measure tool may impact performance. To reduce the 
potential performance impact in the measure tool, real time validation may be turned off. If it is 
turned off, no real time validation will be done when measure changes are made. Validation can 
then manually be initiated in the Rule tool. 
To turn off real time validation: 
1. Deselect the Measure Content Validation Enabled checkbox at the bottom of the measure 

tool. Or 
2. In the Workspace Preferences dialog box, deselect the Measure Content Validation checkbox. 

Working with components 
This section contains the following procedures: 

• Creating a major component 

• Creating a minor component 

• Pushing components down 

• Pulling components up 

• Displaying component 

• Specifying component information 

• Renaming a component 

• Moving component 

Creating a major component 
To create a major component: 

1. From the Measure Definition right-click menu, select Add Major Component. 

Creating a minor component 
To create a minor component: 

1. In the Measure Definition window, select the component under which to create the minor 
component. 

2. From the Measure Definition right-click menu, select Add Minor Component. 
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Pushing components down 
To push a component down: 

1. In the Measure Definition window, select the component that you want to push down. 

2. From the Measure Definition right click menu, select Push Down. 

The component is pushed down one level in the component hierarchy, and a new component is 
created to take the place of the pushed down component. 

 You cannot push down a major component. 

Pulling components up 
To pull a component up: 

1. In the Measure Definition window, select the component that you want to pull up. 

2. From the Measure Definition right click menu, select Pull Up. The component is pulled up 
one level in the component hierarchy. 

3. You cannot pull a minor component up to become a major component. 

Displaying components 
By checking or unchecking the check boxes next to the component names, you determine which 
components are displayed in the Component Defaults tab. 

• If you want to display information about a component in the Component Defaults tab, check 
the box next to the component name. 

• If you do not want to display information about a component in the Component Defaults tab, 
uncheck the box next to the component name. 

 Note: Checking or unchecking a box for a major component causes the boxes for all 
minor components underneath it to be checked or unchecked, accordingly. 

Specifying component information 
To specify component information: 

1. In the Measure Definition tool, select the component for which you want to specify 
information. 

2. On the Components tab, specify the following information applicable to the measures 
inheriting from the component.  

 Note: The defaults entered here will be inherited by the child minor components, and will 
also be inherited by the auto-generated measures.  Not all properties need to be entered 
for all components. Also, properties defined for measures components listed first will 
override properties for components further down the list. 

• Identifier 
The identifier of the component. The identifier is used to create measure names. 

• Label 
The label that is used to generate measure labels, which are displayed to RPAS users. 
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• Description 
A description of the component. 

• Data Type 
Must be one of the following types: 

Real – Floating point numeric values. Most measures are of this type.  

Integer – Numeric integer values. There are no special ‘spreading’ algorithms 
for integer measures, which should normally be used only for measures that are 
calculated ‘bottoms up’.  

Date – Date and time. Can easily be converted to position names by standard 
functions.  

String – Variable length strings, typically used for notes and names.  

Boolean – True or false values, typically used for flags and indicators.  

• NA Value 
The suggested value for unpopulated (na) cells. Initially, the base array of a measure is 
defined with this value; however, the value is subject to change in order to optimize the 
compression factor. 

• Base Intersection 
Lowest level at which data is stored for a measure. Double clicking on this field will 
bring up a dialog box that contains the hierarchies that were defined using the Hierarchy 
tool. One dimension from each hierarchy can be selected. 

• Agg Method 
The default aggregation method for the component: 

recalc – recalculate measure at each level, via recalc expression 

total – for numeric types, sum of all values 

total-pop - for numeric types, sum of all populated values. 

average – for numeric types, average of all values (requires total) 

average_pop – for numeric types, average of populated values (requires total 
and popcount) 

min – minimum of all values 

max – maximum of all values 

min_pop – minimum of populated values 

max_pop – maximum of populated values 

pst – for numeric types, period start total (first along time dimension and total 
along other dimensions) 

pet – for numeric types, period end total 

first – first of all values in base (relevant for ordered dimensions) 

last – last of all values in base (relevant for ordered dimensions) 

first_pop – first populated value in base 

last_pop – last populated value in base 
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and – for Boolean types, and of all values 

or – for Boolean types, or of all values 

ambig – ambig of all values (all values equal, otherwise ambig) 

ambig_pop – ambig of all populated values 

popcount – count of populated values in base 

median – for numeric types, median of all values 

median_pop – for numeric types, median of populated values (requires 
popcount). 

• Spread Method 
The default spread method for the measure: 

none - measure value cannot be spread 

prop – for numeric types, spread value proportionally (non-zero total) or evenly 
(zero total) 

even – for numeric types, spread value evenly 

even_pop – for numeric types, spread value evenly across populated cells 

delta – for numeric types, increment each cell evenly 

delta_pop – for numeric types, increment each cell evenly across populated 
cells 

repl – for all types, replicate the value to each cell 

repl_pop – for all types, replicate the value to each populated cell. 

prop-pop - for numeric types, spread value proportionally to all populated cells. 

ps – for numeric types and pst agg methods, apply delta to starting period with 
decreasing effect towards ending period 

pe – for numeric types and pet agg methods, apply delta to ending period with 
decreasing effect towards starting period 

• Base State - The editability of the measure at the base level (read or write). 

• Agg State - The editability of the measure at the aggregate level (read or write). 

• Database - The database where the measure is stored in the domain. If the database is NA 
then the measure is not stored. Specifies the relative path from domain root. You should 
specify the database as “data/dbname” so the database is built within the data directory of 
the domain. Otherwise, it will build directly in the root directory of the domain. 

• View Type - Indicates if the measure is calculated when viewed. If the view type is not 
none, then the measure must not be materialized (that is, they are not stored in workbook 
or domain) and must appear on the left hand side of one and only one expression in a rule 
group. Synchronized view types are maintained immediately at cell edit time. 

View types include: 

none – measure is stored 

view_only – measure is calculated when viewed (aggstate and basestate must be 
read-only) 
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sync_first_lag – period 1 from first measure (no calendar), periods 2..N from 
second measure 1..N-1 (lag) [eg. bop  os & eop] 

sync_lead_last – periods 1..N-1 from first measure 2..N (lead), period N from 
second measure (no calendar) [eg. eop  bop & cs] 

sync_first – get period 1 from measure (similar to first agg type along calendar 
dimension) [eg. os  bop] 

sync_last – get period N from measure (equivalent to last agg type along 
calendar dimension) [eg. cs  eop] 

• Sync With - A comma-separated list of measures used for synchronization. Depends on 
view type. 

• Insertable - Indicates whether the measure is visible to user for inclusion in workbooks 
(used in addition to measure security). Possible values are true and false. 

• UI Type - Indicates whether the measure is a picklist or not. If a measure is defined as a 
picklist, users must choose a value for the measure from a list of valid values defined 
using the range property. 

• Range - Specify suitable range for the measure at edit time.  For numeric values, the 
syntax is as Lower Bound : Upper Bound. For strings, it is the maximum length.  For 
picklist measures (both numeric and string) values can be explicitly listed as “a,b,c,d…”; 
additionally labels can be specified for each value such as “valuea (labela), valueb 
(labelb), …” where the labels will be displayed in the user interface. 

• Purge Age - The number of days (without a load) before measure data is purged. 

• Refreshable  - No longer used in the RPAS 11.x architecture. Instead, the refresh rule 
group is used to determine which measures are refreshed. This measure property will be 
depreciated soon. 

• Lowerbound - A valid, realized measure name indicating the lowest value that a user can 
enter for this measure. The lowerbound measure and the measure containing the 
lowerbound property must be either type integer or real. Note that as integer value is not 
accepted as a value. A valid, realized measure name must be used as the value. 

• Upperbound - A valid, realized measure name indicating the highest value that a user can 
enter for this measure. The upperbound measure and the measure containing the 
upperbound property must be of either type integer or real. Note that an integer value is 
not accepted as a value. A valid, realized measure name must be used as the value. 

• Materialized - (not visible in the Tools Workbench GUI) A materialized measure is one 
in which it is stored on the domain and calculated by the RPAS calculation engine. A 
non-materialized measure is one in which the measure is calculated "on -the-fly' during 
the fetch process of the RPAS client and thus not stored in the domain. The user does 
NOT have the ability to configure this measure property. The value of this property is 
automatically determined by the Tools Installer during the domain build process. The 
Installer evaluates all rule groups across all rule sets in order to determine the non-
materialized candidates, such that they are globally in effect throughout the entire 
domain. In order for a measure to be non-materialized, it must meet the following 
requirements: 

It cannot have a database. (The database field must not be populated.) 

The Agg Method must be set to recalc. 
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The Base State and Agg State must be set read, meaning it cannot be edited. 

It cannot be the source measure in any rule calculation, meaning it cannot be on 
the RHS (right-hand-side) of a rule. 

It cannot be used as a parameter in a procedure function. 

It must not be a sanity check bounding measure, meaning it cannot be defined 
as an Upperbound or Lowerbound measure for another measure. 

• Special Value Type - the different types that can be used to specify special values. The 
different types include null, cellvalue and user-entered. 

• Special Value - used to allow the user to enter the value when the Special Value Type is 
set to user-entered. 

For the Special Value field, the entry in this field must be of the same data type 
as the measure and validation is enforced in this field. 

For a Boolean measure, when the Special Value Type field is set to User 
Entered, then the only valid entry for the Special Value field is either true or 
false.  

For a Date measure, when the Special Value Type field is set to User Entered, 
then the user needs to enter a date in the format of YYYYMMDD.  If the user 
specifies less than 8 digits or non-numeric, then the cell value will be marked as 
invalid.  A valid entry consists of 8-17 digits.  We only validate if digits are 
used.  We do not validate whether those 8 digits make up a valid date or not. 

By default each measure will be registered with cellvalue as the default special 
value behavior.  For the cases in which a Special Value Type setting, other than 
User-Entered, is used, but a Special Value entry is provided, the Special Value 
entry will not be used, but instead the measure will be registered with cellvalue 
as the default behavior. 

When the user sets the Special Value Type setting to User-Entered, but does not 
provide a Special Value entry, the Special Value Type will not be used, instead 
the measure will be registered with cellvalue as the default behavior. 

When a domain has already been built which includes a measure with a special 
value setting, if the user removes that special value setting for that measure and 
patches the domain, the measure will get updated with cellvalue as the default 
special behavior. 

RPAS allows for the special value measure property to be updated 

• Dimension Attribute – a checkbox indicating that the measure should be registered as a 
dimension attribute.  For a measure to be eligible to be a dimension attribute, the 
following requirements must be met: 

The measure must be a realized measure. 

The measure has a base-intersection that is 1-dimensional 

The database field is filled in with a value 

There is no restriction on the type of measure that can be specified as a 
dimension attribute. 
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• Dimension Attribute Name – optional field, only to be used if the measure is set to be a 
dimension attribute measure. 

• Dimension Attribute Label – optional field, only to be used if the measure is set to be a 
dimension attribute measure. 

• Allowed Aggs – the set of the allowable aggregation methods for the measure based on 
the measure data type. 

Renaming a component 
To rename a component: 

1. In the Measure Definition window, select the component that you want to rename. 

2. From the Measure Definition right-click menu, select Rename. 

3. Type the new name for the component, or click the component name twice, and then type the 
new name. 

 Note: Changing the component name changes the component label, not the identifier. 

Moving components 
To move a measure from one component to another: 

1. In the Measure Definition window, select the component that you want to move. 

2. Drag the component to its new location and release it. 

 Note: You cannot move a major component. 

Working with measures 
By selecting major and minor components that were defined, the Measure Tool will create and 
name the measures. These measures will inherit the component properties that were defined. 
Measure properties can then be over-written for individual measures, if desired, by entering them 
the same way as on the components tab. Note that once over-written at the measure level, changes 
made at the component level will no longer spread down to that measure as it will retain the over-
written value. 

This section contains the following procedures:  

• Creating Measures 

• Realizing and unrealizing measures 

• Renaming a measure 

• Showing measures 

• Hiding measures 

• Filtering measures 

Creating measures 
Measures are created by selecting the components for which you want use to construct measures. 
The measure tool will generate measures for all of the combinations that you select. This saves 
you from creating all of the measures manually. 
To create measures: 
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1. Select the measures tab. 

2. In the components tree, select the check boxes for the components you want to use to create 
measures. 

3. The measure tool will create measures using all of the combination of components that you 
selected. 

Realizing and unrealizing measures 
When a measure is generated by the Measure Tool, it is considered a prototype measure and 
cannot be edited or used in any other configuration component. To enable the measure to be 
edited and/or used elsewhere in the configuration, it must be realized first. 

To realize a measure: 

1. In the Measure Definition window, select the components containing the measures you want 
to realize. 

2. In the Measures tab, for each measure that you want to realize, select the check box in the 
Realized column. 

OR 

1. If you want to realize all measures in the components you selected, from the Measures tab 
right-click menu select Realize All. 

 

To unrealized a measure: 

1. In the Measure Definition window, select the components containing the measures you want 
to unrealize. 

2. In the Measures tab, for each measure that you want to unrealize, deselect the check box in 
the Realized column. 

OR 

1. If you want to unrealize all measures in the components you selected, from the Measures tab 
right-click menu select Unrealize All. 

Renaming a measure 
To rename a measure: 

1. In the Measures tab, click the name of the measure you want to rename. 

2. Type the new name for the measure. 

 Note: The measure must be realized before you can rename it. 

Showing measures 
To show a measure: 

1. In the Measure Definition window, check the check boxes next to the components whose 
measures you want to show. 

OR 

1. Select the components containing the measures you want to show. 
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2. From the Measure Definition right-click menu, select Show. 

 

To show all measures: 

1. From the Measure Definition right-click menu, select Show All. 

2. Due to memory constraints, depending on the number of measures created it may not be 
possible for the Measure Tool to display all generated measures to be displayed. In this case, 
you will receive an error message instructing you to deselect some measure components. 

Hiding measures 
To hide a measure: 

1. In the Measure Definition window, uncheck the check boxes next to the components whose 
measures you want to hide. 

OR 

1. Select the components containing the measures you want to hide. 

2. From the Measure Definition right-click menu, select Hide. 

To hide all measures: 

1. From the Measure Definition right-click menu, select Hide All. 

Filtering measures 
In the Realized Measure tabs, you can sort measures by property value.  

To filter measures: 

1. In the Realized Measures tab, click in the filter field at the top of the table for the property 
that you want the measures filtered by. 

2. Enter the value on which measures are to be filtered. Note that this field is case sensitive. The 
measures are filtered according to the value of the property entered. 
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Chapter 7- Rules 
The rule definition tool allows you to define, organize, and manage rules, rule groups, and rule 
sets. It also allows you to create expressions and add expressions to rules. 

Understanding the RPAS calculation engine 
The RPAS calculation engine is an engine that is built to support OLAP type calculations against 
a multi-dimensional model. The engine is very powerful and flexible, and, at first sight, very 
complex. However, when the ‘building blocks’ of the calculation engine are properly understood, 
much of this apparent complexity goes away. This overview of the calculation engine processes 
will therefore start by describing the three fundamental processes of aggregation, spreading and 
expression evaluation, before explaining how the various processes integrate into a 
comprehensive whole. 

RPAS supports an OLAP type model. In this model, individual pieces of data, named ‘cells’, 
apply to a single position in one or more hierarchies or dimensions. These will typically include a 
‘measures’ dimension, a calendar or time hierarchy, and other hierarchies such as for products 
and locations. The measures dimension is fundamentally different to the other hierarchies, since 
measures (which in other systems may be referred to by terms such as facts, performance 
indicators or variables) represent the fundamental events or measurements that are being 
recorded, whereas the positions in the other hierarchies provide a context for the measurement: 
where, when, what, etc. Measures relate to one another through rules and expressions: positions 
in all the other hierarchies relate to each other through hierarchical relationships. 

RPAS supports two different forms of relationships between cells: hierarchical relationships that 
require ‘aggregation’ and ‘spreading’, and measure relationships that require rules and 
expressions. Hierarchical relationships, such as weeks rolling up to months, or stores rolling up to 
regions, require the aggregation of data values from lower levels in a hierarchy to higher levels, 
using a variety of methods, as appropriate to the measure. To enable such data to be manipulated 
at higher levels, RPAS supports ‘spreading’ the changes, also using a variety of methods. 
Aggregation and spreading are basic capabilities of the engine that require no coding by the 
implementer, other than the selection of aggregation and spreading types to use for a measure. 

The inherent relationships between measures can be modeled through a rich rule and expression 
syntax. Most of the effort in configuring an application model is in modeling these relationships. 

The RPAS calculation engine is designed to be robust, and extensible, but in complete control of 
the calculation process. It enforces integrity of the data by ensuring that, where possible, all 
known ‘relationships’ between cells, for whatever reason, are always enforced. Much of the logic 
of the processing of rules and rule groups depends on this basic principal. 

Related topics: 

• Expressions 

• Rules 

• Rule groups 

• Rule group transitions 
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Expressions 
Expressions are the basis of all calculations of the relationships between measures, and are 
evaluated by the calculation engine during a calculation. Expressions are written in a syntax that 
allows for the calculation of a single measure from other measures, constants and parameters, 
using standard arithmetical functions and a rich set of mathematical, technical and business 
functions. Expressions are therefore an algorithmic statement of a relationship between measures. 

Rules 
An expression describes the relationship between measures in a way that causes a measure to be 
calculated through the expression. An expression may be said to ‘solve’ the relationship for the 
measure that is calculated through the expression. In some cases, there may be business 
methodology reasons for wanting more than one of the measures in a relationship to be calculable 
or solvable through that relationship. To support this requirement, RPAS has the concept of a 
rule, which consists of one or more expressions that describe the same relationship between 
measures, but that solve for different measures. All the expressions in a rule must use the same 
measures, and must have a different target measure (i.e. the measure on the left hand side of the 
expression that is calculated by the expression). 

Where a rule has multiple expressions, those expressions are given a priority sequence, to help 
the calculation engine to select a calculation path that follows business priorities. Consider the 
rule that relates together sales value, sales units and sales price. Let us assume that there are three 
expressions in this rule, that is, that each of the measures involved in the rule may be ‘solved’ 
through the rule. If a user makes a change to, say, sales value, it should be clear that the 
calculation engine could enforce the mutual integrity of all the cells by holding the sales price 
constant and recalculating a new sales units. It could also achieve the same end by keeping the 
sales units constant, and recalculating the sales price. Both approaches are mathematically valid, 
and produce a consistent result, with complete data integrity. However, it is likely that one 
approach makes more ‘business sense’ than the other (in this case, most businesses in most 
circumstances would want the price to remain constant and have the units recalculated), and the 
prioritization of the expressions in the rule provides this information to the calculation engine. 
Considerable care should be taken in the design of models to ensure that appropriate expression 
priorities are established. 

In essence, the calculation engine, when given a choice, will always select the highest priority 
expression in the rule that is available to be selected. In this example, therefore, the expression 
that calculates sales units would have a higher priority than the expression that calculates sales 
price. Similar consideration of the desired effect of a change to sales units will probably lead to a 
conclusion that the expression that calculates sales value would also have a higher priority than 
the expression that calculates sales price. But what of the relative priority of the expressions to 
calculate sales value and sales units? What is the ‘business priority’ for those expressions? That 
may vary from implementation to implementation. Indeed, it may even vary from one type of 
plan to another in the same implementation: for a financial merchandise plan, the preferred 
behavior may be that a change to just sales price causes a recalculation of the sales units, whereas 
in a unit oriented lower level plan, the preferred behavior may be that a change to just sales price 
causes a recalculation of sales value. 

The same measure may appear in multiple rules. Indeed, this will frequently be necessary, since 
the same measure can be involved in a number of different relationships with other measures. For 
example, there may be a relationship between sales value, sales units and sales price. Sales value 
may also be involved in another relationship with closing stock and a cover value, and yet another 
with opening stock, receipts, markdowns and closing stock.  
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Rule groups 
It is most unusual for a model to only require a single rule. In most cases, there will be a 
collection of relationships between measures that must be maintained. In RPAS, a Rule Group is 
a collection of rules that are treated as a unit by the calculation engine, with the integrity of all the 
rules in the rule group being maintained together. The calculation engine always has one (and 
only one) active rule group. Even if all that is required is a single expression, that single 
expression will be in a rule, and that single rule will be in a rule group.  

Rules within a rule group are given a priority. The calculation engine uses this to select a 
calculation path that follows business priorities, by using rule priorities to determine which rule to 
enforce when there is a choice to be made  

Within a system as a whole, there may be many rules defined. The validation of rules is 
performed in isolation, but rules within a rule group are also validated in the context of all the 
other rules in the rule group. This can mean that a rule that is perfectly valid syntactically, is not 
valid within a particular rule group. Rule group validations include: 

 Each rule in a rule group must represent a completely different measure relationship. 
Therefore no two rules in a rule group may use exactly the same collection of measures, and 
neither may one rule group use a collection of measures that is a sub-set of the collection of 
measures in another rule. 

 There must be an expression that calculates each recalc measure 

 Any measure that is on the LHS of the only expression in a rule may not be on the LHS of 
any other expression. 

Although there may only be one active rule group at any time, RPAS allows for the definition of 
multiple rule groups to satisfy different calculation requirements. Rule groups may be one of four 
different types: load, calculate, refresh and commit. The RPAS application automatically uses the 
load rule group when loading data into the workbook, the refresh rule group to refresh data and 
the commit rule group when committing data to the domain. These rule groups are perfectly 
‘normal’, so although they will typically include many rules that use the master modifier to load 
or commit data, they may also have other rules. It is perfectly possible, for example, to commit 
data to the domain for a measure that does not exist in the workbook, merely by including the 
appropriate rule to calculate the measure (with the master modifier) in the commit rule group. 
Similarly, a measure may be loaded into a workbook that does not exist in the domain, by 
including an appropriate rule to calculate the measure in the load rule group. 

RPAS supports multiple calculation rule groups. Menu options may be configured to allow the 
user to select a different calculation rule group. RPAS ensures a smooth transition from one calc 
rule group to another. 

Multiple Refresh Rule Groups 
The Configuration Tools and RPAS support the use of multiple refresh rule groups.  Within the 
rule tool, there is the ability to create multiple refresh rule groups within a rule set. These multiple 
refresh rule groups can then be assigned to a workbook template using the Workbook Designer, 
and will be available for the user to select from in the RPAS client. 
• All multiple rule groups for the refresh category must be in the same rule set if you intend to 

use them in a workbook.  The workbook will have a single rule set for the entire workbook. 

• You may consider naming your rule groups so the refresh rules groups are reflected in the 
name, such as Sales_refresh1, Sales_refresh2, etc. 
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Rule group transitions 
Although only a single rule group may be active at any time, RPAS supports the transition from 
one rule group to another. The calculation engine ensures the integrity of measure relationships at 
all times, so this process is not merely a case of switching from one rule group to another, as there 
is no guarantee that the integrity of the rules in the rule group being transitioned into have been 
maintained.  

RPAS makes a worse case assumption when transitioning rule groups. Any rule that is in both the 
old and new rule groups is assumed to have its integrity maintained. Any other rule is assumed to 
be potentially wrong, and so is flagged as ‘affected’. A normal calculation is then initiated, with 
expressions to be evaluated determined by the usual process. All affected rules will therefore 
have their integrity imposed by the evaluation of an expression, and ‘knock-on’ effects may cause 
some rules that occur in both the old and new rule groups to also be evaluated. Since all base 
intersections must be calculated during rule group transition, a large or complex rule group 
transition is likely to take longer than a normal calculate. 

Note that there are circumstances when automatic rule group transitions occur: 

 On data loading. Data is loaded using the load rule group. This will typically load measures 
by calculating them from the data values held on the domain using the master modifier, but 
may also calculate other measures that are not explicitly loaded. When the load is complete, 
the system will automatically transition to the calculate rule group  

 On data refreshing. Data refreshing causes some measures to be updated from values held on 
the domain. The measures to be refreshed will have been selected by the user. Refreshing 
uses the refresh rule group, but there is no real transition: the measures that are affected by 
the refreshed measures are treated as affected in the calculate rule group, and a normal 
calculate of that rule group follows. Effectively, data refreshing causes a calculation using the 
calculate rule group as if the cells that were refreshed were directly changed by the user. 

 On data committing. There is a normal transition from the current calculate rule group to the 
commit rule group. This will typically commit measures by calculating them on the domain 
by using the master modifier. If any non-master measures are calculated, they will be treated 
as refreshed, and there will be a ‘refresh’ transition back to the calculate rule group. 

 On workbook building. When a workbook is built, there is an automatic transition from the 
load rule group to the calc rule group. 

Understanding RPAS functions 
RPAS Functions are mechanisms for performing operations within an expression that are 
controlled and executed by the calculation engine. 

 There is always a single measure on the left hand side of a normal expression; that is, a 
function always has only one measure output. 

 The calculation engine controls and executes the evaluation of a function. 

 Functions may be used in long expressions with other functions and keywords. 

 The data that can be referenced is limited to the scope of the workbook. 

Refer to the RPAS 11 Rule Functions document for details about RPAS functions. 
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Working with rule sets 
This section contains the following procedures: 

 Adding a rule set 

 Deleting a rule set 

 Renaming a rule set 

Adding a rule set 
To add a rule set: 

1. From the Rule Definition right-click menu, or from the toolbar, select Add and then select 
Rule Set. 

2. Type the Name and Description of the rule set. 

 Note: The name can contain a maximum of 10 characters, consisting of letters, numbers, 
and spaces only. 

3. Click OK to create the rule set. 

The rule set is created, along with the following default rule groups: load, commit, calc, and 
refresh. The rule group names are prefixed with the name of the rule set followed by an 
underscore. 

Deleting a rule set 
To delete a rule set: 

1. In the Rule Definition window, select the rule set that you want to delete. 

2. From the Rule Definition right-click menu or the Toolbar, select Delete and then select Rule 
Set. 

3. Click Yes in the Confirm Delete dialog box to delete the rule set. 

Renaming a rule set 
To rename a rule set: 

1. In the Rule Definition window, select the rule set that you want to rename. 

2. From the Rule Definition right-click menu or from the toolbar, select Rename and then select 
Rule Set. 

3. Type the new Name and Description for the rule set. 

4. Click OK to accept the new name and description. 

Working with rule groups 
This section contains the following procedures: 

 Creating a rule group 

 Deleting a rule group 

 Renaming a rule group 

 Copying a rule group 
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Creating a rule group 
To create a rule group: 

1. In the Rule Definition window, select the rule set in which to create a new rule group. 

2. From the Rule Definition right-click menu or from the toolbar, select New and then select 
Rule Group. 

3. Type the Name and Description for the rule group. 

 A Rule Group name can be a maximum of 16 characters. 

4. Click OK to create the rule group. 

Deleting a rule group 
To delete a rule group: 

1. In the Rule Definition window, select the rule group that you want to delete. 

 Note: You can only delete user-created rule groups. You cannot delete the default load, 
commit, calc, and refresh rule groups. Selecting delete for one of the default rule groups 
will result in all rules and expressions within the rule group to be deleted. 

2. From the Rule Definition right-click menu or from the toolbar, select Delete and then select 
Rule Group. 

3. Click Yes in the Confirm Delete dialog box to delete the rule group. 

Renaming a rule group 
To rename a rule group: 

1. In the Rule Definition window, select the rule group that you want to rename. 

2. From the Rule Definition right-click menu or from the toolbar select Rename and then select 
Rule Group. 

3. Type the new Name and Description for the rule group. 

4. Click OK to accept the new name and description. 

Copying a rule group 
To copy a rule group: 

1. In the Rule Definition window, select the rule group that you want to copy. 

2. From the Rule Definition right-click menu or from the toolbar, select Advanced-Copy Rule 
Group. 

3. In the Rule Set field select the desired destination Rule Set. 

4. In the Rule Group frame select the desired destination Rule Group. 

5. Select Replace or Append. Replace will overwrite all rules that already exist in the 
destination rule group. Append will add to the rules already in the destination rule group. 

6. Click OK. 
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Measure Validation within the Rule Tool 
If measure content validation has been turned off in the Measure Tool (see Working with 
Measures chapter). Measure validation must be manually initiated in the rule tool. To do this: 

1. Click the perform Measure Content Validation button on the toolbar in the Rule Tool. 

Working with rules 
This section contains the following procedures: 

• Creating a rule 

• Building an expression 

• Rule/expression ordering 

• Editing an expression 

• Adding an expression 

• Deleting an expression 

• Applying a rule pattern 

• Deleting a rule 

• Renaming a rule 

• Renaming all rules 

• Filtering rules 

• Auto-generating load and commit rules 

• Copying rules 

Creating a rule 
To create a rule: 

1. In the Rule Definition window, select the rule group in which to create a rule. 

2. From the Rule Definition right-click menu or from the toolbar, select New and then select 
Rule. 

3. Type the Name and Description for the rule. 

 Rule names can contain a maximum of 14 characters. 

4. If you want to add an expression to the rule, click Next. Otherwise, go to step 6. 

5. To add an expression to the rule, do one of the following: 

 Enter the expression directly into the expression text box. 

 Click the Expression Builder button to the right of the text box.  See Building an 
expression for more information. 

6. Click Finish to create the rule. 
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Building an expression 
To build an expression: 

1. Click the button to the right of the expression field to open the Expression Builder. 

2. In the Expression Builder window, select the desired measure components to display 
measures. Based on the component selections made, realized measure will be displayed. 

3. Select the measures you want to use in the expression by double clicking on them. 

4. Using the selected measures, the functions available from the dropdown list, and the 
mathematical operators, construct an expression. 

5. Click Finish to return to the previous window. If you have created an invalid expression, a 
warning message is displayed and the font color is red.  

Rule/expression ordering 
To order a rule or expression: 

1. In the Rule Definition window, select the rule or expression that you want to move. 

2. Click the down arrow to move the rule or expression down the list, or click the up arrow to 
move the rule or expression up the list. 

Editing an expression 
To edit an expression: 

1. In the Rule Definition window, select the rule group containing the expression you want to 
edit. 

2. Select the rule containing the expression you want to edit. 

3. From the Rule right-click menu or from the toolbar, select Edit Expressions. 

4. Either edit the expression in the text box or click the button to the right of the text box to edit 
the expression using the Expression Builder.  See Building an expression for information on 
using the Expression Builder. 

5. Click OK to accept the changes you made to the expression. 

Adding an expression 
To add an expression to a rule: 

1. In the Rule Definition window, select the rule group containing the rule to which you want to 
add an expression. 

2. Select the rule to which you want to add an expression. 

3. From the Rule right-click menu or from the toolbar, select Edit Expression. 

4. In the Edit Expressions window, click Add. 

5. Either type the expression in the text box, or click the Expression Builder button to create an 
expression using the Expression Builder.  See Building an expression for information on 
using the Expression Builder. 

6. Click OK to add the expression to the rule. 
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Deleting an expression 
To delete an expression: 

1. In the Rule Definition window, select the rule group containing the expression you want to 
delete. 

2. Select the rule containing the expression you want to delete. 

3. From the Rule right-click menu or from the toolbar, select Edit Expressions. 

4. Click Delete next to the expression you want to delete. 

5. Click OK to accept the changes you made. 

Applying a rule pattern 
To apply a rule pattern: 

1. Select the rule to use as the pattern basis. 

2. Select Apply Pattern from the right click menu. A dialog box will be displayed listing 
candidate rules patterned after the selected rule.  

3. Select the desired rules. 

4. Click OK. 

Deleting a rule 
To delete a rule: 

1. In the Rule Definition window, select the rule group containing the rule you want to delete. 

2. Select the rule you want to delete. Multiple rules can be selected by holding down the CTRL 
key 

3. From the Rule right-click menu or from the toolbar, select Delete and then select Rule. 

4. Click Yes in the Confirm Delete dialog box to delete the rule. 

Renaming a rule 
To rename a rule: 

1. In the Rule Definition window, select the rule group containing the rule you want to rename. 

2. Select the rule you want to rename. 

3. From the Rule right-click menu or from the toolbar, select Rename Rule. 

4. Type the new Name and Description for the rule. 

5. Click OK to accept the new name and description. 

Renaming all rules 
To rename all rules within a rule group: 

1. In the Rule Definition window, select the rule group containing the rules you want to rename. 

2. From the Rule right click menu or toolbar, select Advanced, Rename All Rules. 

3. Enter a prefix to be pre-pended to all rule names. 
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4. Click Yes on the Confirm Operation dialog. Note: Renaming all rules is not an un-doable 
function.  

5. Click OK. All rules in the rule group will be renamed with the prefix followed by a 4 digit 
numeric identifier generated by the rule tool.  The rule tool will maintain the order the rules 
were in before they were renamed. 

Filtering rules 
To filter rules: 

1. In the Rule Definition window, click Rule Filtering. 

2. Select one of the following options: 

 Disable Filtering 
All rules are displayed. 

 Filter by Measure 
Works in conjunction with the measure components box in the bottom left corner of the 
screen. Rules are filtered to show those whose measures conform to the selected class 
scheme. 

 Filter by Size 
Rules are filtered to show those with more than one expression. 

 Filter by Validity 
Only invalid rules are displayed. 

Only those rules satisfying the filtering criteria are displayed. 

Auto generating load and commit rules 
Rules for the load and commit rule groups can be auto-generated based on the calc rule group. To 
auto-generate load or commit rules: 

1. Select the calc rule group to use as a basis. 

2. Right-click or from the toolbar, select Advanced. 

3. Select Generate Load Rules or Generate Calc Rules 

4. Click Yes on the Non-Undoable dialog box. This will also clear out the undo stack. 

5. Note: Measures to be used in the load rule group must have a database assigned in the 
Measure tool. 

Copying rules 
To copy rules: 

1. Select the rules to be copied. Note: to select more than one rule, hold down the CTRL key. 

2. Right-click in the Rule/Expression frame in the Rule Definition Tool. 

3. Select Copy Selected Rules. 

4. In the Rule Set field, select the desired destination Rule Set. 

5. In the Rule Group frame, select the desired destination Rule Group. 
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6. Select Replace or Append.  
Replace will overwrite all rules that already exist in the destination rule group. Append will 
add to the rules already in the destination rule group. 

7. Click Next. 

8. Select the rules to be copied by selecting the check boxes for the desired rules. 

9. Click Finish. 

To find and replace measures in the copied rules: 

1. Click Find/Replace. 

2. In the Find field enter the portion of the measure you wish to replace. 

3. Note: The Find function is case sensitive. 

4. In the Replace With field enter the measure replacement. 

5. Select Forwards or Backwards to search the rules either forwards or backwards in the rule 
list. 

6. Click Find Next. The first candidate measure to be replaced will be displayed in the bottom 
left field. 

7. Click the Replace/Find Next to replace the current candidate measure and display the next 
candidate measure. 
OR 
Click Replace All to replace all instances of the measure. 

8. When you are finished, close the Find/Replace box. 

9. Click the Finish. 
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Chapter 8– Workbooks 
The workbook designer allows you to create, select and integrate the various components of a 
workbook template: tabs, worksheets, rule groups, wizards, and workflow processes. 

A workbook is the easily viewed, easily manipulated multidimensional framework used to 
perform specific business functions in the configured solution. To present data, a workbook can 
contain any number of multidimensional spreadsheets, called worksheets, as well as graphical 
charts and related reports. All of these components work together to facilitate viewing and 
analysis of business functions. 

A workbook tab is a major subdivision of a workbook. A workbook must contain at least one 
workbook tab, but it can also contain many tabs. 

A workbook tab must contain at least one worksheet, but it can also contain many worksheets. 
 Worksheets are multidimensional spreadsheets used to display workbook-specific information. 
Workbooks can include one or many worksheets. Worksheets can present data in the form of 
numbers in a grid, or these numeric data values can be easily converted to a graphical chart. 

Wizards are used to build workbooks in the RPAS client. By specifying requested information on 
wizard pages, a workbook will be created. The workbook designer allows you to specify which 
wizards will be used to build the workbooks. 

Working with workbooks 
This section contains the following procedures: 

 Creating a workbook 

 Editing workbook properties 

 Removing a workbook 

Creating a workbook 
To create a workbook: 

1. In the Workbook Designer window, click the New Workbook button or right click to use the 
context menu. 

Editing workbook properties 
To edit workbook properties: 

1. Select the name of the workbook whose properties you want to edit from the Workbook 
Designer tree. 

2. In the General tab, type the RPAS Name, User Label, and Group. 

3. Select the Rule Set to use with the workbook. 

4. If you want the workbook to be accessible through a wizard only, check the Wizard Only 
box. 

5. If you do not want to use the default rules associated with the rule set, uncheck the Use 
Default Rules check box. Then specify the Load Rules, Commit Rules, Calc Rules, and 
Refresh Rules for the workbook. Aside from the refresh rule only one rule group for each 
category can be selected. 
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6. Optional: If multiple refresh rule groups have been defined for the selected rule set, click on 
the refresh rule group field to bring up a dialog box to select and order those rule groups. The 
order of the refresh rule groups is the order in which they will be displayed within the RPAS 
client. The first rule group in the ordered list will be the default refresh rule group in the 
RPAS client. 

7. Click on one of the x-axis, y-axis, z-axis or unassigned fields. In the axis dialog screen 
specify the default axis layout to use with all worksheets in this workbook by placing the 
hierarchies on the appropriate axis. Hierarchies will be positioned in the worksheet based on 
this. You can override the defaults by specifying axis information in the worksheet properties. 

8. Specify either the Standard or Custom wizard to use for the workable template. 

 Standard: 

a. Click on the standard wizard field. The standard wizard dialog box will be displayed. 
Hierarchies that are used in the base intersections for the measures used in the rule set 
assigned to the workbook will be displayed.  

b. Select the desired dimension from each hierarchy. This will specify the base 
intersection from which a Workbook can be built in the RPAS client. 

c. Enter the left and right labels for each hierarchy. These labels will be displayed 
during the workbook wizard process. 

d. Adjust the order of the hierarchies as necessary by dragging them. This will be the 
order of the wizards during the workbook build process. 

e. Select the OK button when finished. The dimensionality of the workbook will be 
displayed in the Standard wizard field. 

 Custom: 

a. If custom wizard layouts have been defined using the Wizard Designer, click on the 
pick list and select the custom wizard that you wish to be used to build the 
Workbook. 

9. Optional: In the Custom Menus tab, use the right-click menu to add the custom menu. This 
tab is optional and is used to create a menu-driven process within the workbook using rule 
group transitioning. For example, custom menus are used to define an approval process. 

 Menu Label 
The name of the menu that will be displayed in the RPAS client. 

 Label 
The label that will be displayed in the menu. 

 Function 
Defaults to RuleGroupProcessor and cannot be changed. 

 Arguments 
The rule groups to be used in the process, separated by commas. 

 Note: Duplicate label names are not allowed. 

10. Optional: In the Hier Mods tab, for each hierarchy, enter the dimensions separated by 
commas. 
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 Note: This tab is optional. The Hier Mods (Hierarchy Modifications) function is used to 
define the workbook hierarchy structure if different from what is defined using the 
hierarchy tool. For example, if the Product Hierarchy Dimensions are configured as Dept, 
Class, Style, Sku, but in the Workbook only Dept and Class need to be visible, Hier Mods 
would be used. 

11. Optional: In the Dynamic Hierarchies tab: 

 Note: This tab is optional and is used to configure a hierarchy whose member positions 
are dynamic and not constant. For example, if Cluster is an alternate hierarchy off of 
Store in the Location Hierarchy, and the stores that are included in the cluster can differ 
by product 

 Name 
The name of the dynamic hierarchy. Duplicate names are not allowed. 

 Measure 
Click on the Select Measure button to get a list of the measures used in the Workbook. 
Double click to select the desired measure. 

 Label Measure 
Enter the label measure. 

 Measure Hier 
Enter the measure hierarchy. 

 Measure Dim 
Enter the measure dimension. 

 Hier 
Enter the hierarchy. 

 Dim 
Enter the dimension. 

 Modified Dim 
Enter the modified dimension. 

 Note: Measures that have been unrealized, renamed, or realized are displayed in red. 

12. Optional: The Measures tab allows you to override the following measure information at the 
workbook level: Label, Description, Base State, Agg State, UI Type, Range, Loadrange, and 
Loadrange Measure.  In the Measures tab: 

a. To add a measure, right click in the gray area and select Add. 

b. Click on the row for the new measure and highlight it, then click the Select Measure 
button. 

c. Select the desired measure from the list of realized measures used in the rule set assigned 
to the workbook. 

d. Specify the desired property information. 

e. To apply values to the loadRange and LoadRange measure properties, using the right 
mouse content menu, select Set Dynamic Picklist. Then, doubleclick in the LoadRange 
cell and the loadRange dialog box will be displayed. Enter the dynamic picklist sort 
options as necessary. 
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13. Optional: In the Extended Measures tab, you can configure extended measures which 
represent different usages of the original base measure.  These extended measures include 
using different aggregation methods for the same base measure, or participation measures, 
such as absolute and relative percent to parent measures.  These extended measures can then 
be added onto worksheet profiles to be viewed in the RPAS client 

 Note: If you are setting properties for the first time for a workbook, the next steps you 
would want to take are creating a workbook tab, creating a worksheet and assigning 
measures to worksheets.  

Removing a workbook 
To remove a workbook: 

1. Select the workbook that you want to remove. 

2. Click the Remove button and select the workbook name. 

3. Click Yes in the Confirm Delete dialog box to delete the workbook. Associated Worksheets 
and Tabs will also be removed. 

Working with workbook tabs 
This section contains the following procedures: 

 Creating a workbook tab 

 Moving a workbook tab 

 Editing workbook tab properties 

 Removing a workbook tab 

Creating a workbook tab 
To create a workbook tab: 

1. Select the workbook in which to create a new workbook tab. 

2. Click on the folder icon to Create a New Workbook Tab. 

Moving a workbook tab 
To move a workbook tab: 

1. Select the workbook containing the workbook tab you want to move. 

2. Select the workbook tab that you want to move. 

3. Click the Up or Down buttons, depending on where you want to move the workbook tab. 

4. Note: You must repeat this step for each position you want to move the workbook tab. 
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Editing workbook tab properties 
To edit workbook tab properties: 

1. Select the workbook tab whose properties you want to edit.. 

2. In the General tab, type the RPAS Name and the User Label. 

Removing a workbook tab 
To remove a workbook tab: 

1. Select the workbook tab that you want to remove 

2. Click on the Remove button to remove the selected workbook tab. 

3. Click Yes in the Confirm Delete dialog box to delete the workbook tab. 

Working with worksheets 
This section contains the following procedures: 

 Creating a worksheet 

 Editing worksheet properties 

 Removing a worksheet 

 Adding measures to a worksheet 

Creating a worksheet 
To create a worksheet: 

1. Select the workbook tab for the appropriate workbook in which to create a new worksheet. 

2. Click Create a New Worksheet. 

Editing worksheet properties 
To edit worksheet properties: 

1. Select the worksheet whose properties you want to edit. 

2. In the General tab, type the RPAS Name and the User Label. 

3. In the General tab, by clicking on the field value for x-axis, y-axis, z-axis or unassigned, the 
axis dialog box will be displayed. Specify which hierarchies should be assigned to each axis. 
 This setting overrides the default axis information specified in the workbook properties 
dialog. By checking the Use Default Axis layout box, the axis layout for the workbook will 
be in effect for the worksheet. 

4. Click on the value for the Base Intersection field. The base intersection dialog box will be 
displayed. Select the dimensionality for each hierarchy. Click the OK button. 

5. Optional:  Position queries allow the user to view positions in one dimension based on the 
current position of the dimension that is in the slice area of the worksheet.  The position 
query is a Boolean measure based on the dimension being queried. 

In the Position Queries tab, enter the information for the following fields: 
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 Right mouse click to use the context menu to add a position query. Enter the following 
information for each position query. 

 Name - The name of the property. 

 Note: Duplicate names are not allowed. 

 Label - Enter the label. 

 Measure - Click on the Select Measure button to get a list of the measures used in the 
Workbook. Double click to select the desired measure. 

 Dimension - Select a dimension from the list of dimensions for the measure you selected. 

Removing a worksheet 
To remove a worksheet from a workbook: 

1. Select the worksheet you want to remove. 

2. Click Remove to remove the selected worksheet. 

3. Click Yes to confirm deletion. 

Adding measures to a worksheet 
There are three different categories of measures that are used on worksheets: default profile, 
viewable profile and hidden measures. 

The default profile contains the list of measures that will initially be displayed for this worksheet 
in the RPAS client.  There must be at least one measure on the default profile or the worksheet 
will be invalid in the Tools. 

The viewable profile contains the list of measures that are not initially displayed, but that the 
RPAS client user can add to be displayed in their view of the worksheet by using the Show/Hide 
functionality within the RPAS client. 

There is also a third category of measures that cannot be viewed in the workbook designer – 
hidden measures. Measures that are considered hidden are those that are used in the rule set 
assigned to a workbook, but that are not assigned to any of the profiles in any of the worksheets 
contained in that workbook. This might include measures that are used purely for calculation 
purposes and would have no usefulness to the RPAS client user. 

Additionally, extended measures, which represent different usages of the original base measures 
can be added to the default or viewable worksheet profile.  You can add extended measures that 
are aggregated based on different aggregation methods.  The aggregation methods available for 
selection are based on the Allowed Aggs of the base measure.  The same base measure can have 
multiple extended measures based on different aggregation methods. 

You can also add extended measures that represent the relative and absolute percent to parent 
contributions.  The same base measure can have multiple extended measures based on different 
selections for relative and absolute percent to parent contributions. 

To add measures to a worksheet: 

1. Select the desired checkboxes next to the Measure components in the Selected Component 
column for the corresponding measures to add. The matching measures will appear in the 
Matching Measures column as the components are checked. Only realized measures used in 
the rule set assigned to the selected workbook will be displayed. 
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2. Select the measures to add from the Matching Measures column. 

3. Drag and drop the measure into either the Viewable or Default profile.   

If a measure is added to the Default profile it will also be added to the viewable profile. 
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Chapter 9– Wizards 
This section describes the tasks you can perform using the wizard designer. The wizard designer 
allows you to define the graphical wizard layout for custom wizards. 

Working with wizards 
This section contains the following procedures: 

 Creating a wizard group 

 Creating a wizard page 

 Copying a wizard group 

 Copying a wizard page 

 Editing control properties 

Creating a wizard group 
To create a new wizard group: 

1. In the Wizard Designer window, click the Create a New Wizard button. 

Creating a wizard page 
To create a new wizard page: 

1. Click one of the following buttons, depending on which control you want to add: 

 Create a new dynamic wizard 

 Create a new two tier page  

 Add a label 
A non-editable text field. 

 Add a radio button 
Used to select one option from a group of options, when only one can be specified. 

 Add a check box 
Used to select from a group of options when one or more can be specified. 

 Add a combo box 
The user can select from choices presented on a drop-down list. 

 Add a text box 
A single- or multi-line text field that the user can edit. 

 Add a list box 
Creates a list box widget that can be configured. 

 Add a group box 
A labeled box to group other wizard elements. 

 Add a tree 
A drop-down listbox that displays hierarchical elements in a tree structure. 



Retek Predictive Application Server 
 

60 

 Add a two tree 
A control consisting of two related tree controls. The left tree control is typically used to 
display all the possible selections that can be made from a hierarchy structure. The right 
tree displays only those elements of the left tree that are selected. 

 Add a generic widget 

2. Click on the wizard page grid to place the selected control on the page. 

3. If necessary, reposition the control by dragging it to the appropriate place on the grid. 

Copying a wizard group 
To copy a wizard: 

1. On the wizard page, click the control whose properties you want to edit. 

2. Type the appropriate information for each of the following fields: 

Copying a wizard page 
To copy a wizard page: 

1. On the wizard page, click the control whose properties you want to edit. 

2. Type the appropriate information for each of the following fields: 

Editing control properties 
To edit control properties: 

1. On the wizard page, click the control whose properties you want to edit. 

2. Type the appropriate information for each of the following fields: 

 name 
The RPAS internal name of the control. 

 type 
The control type. 

 text 
The text to be displayed on the control label. 

 align 
The same as the style attribute. Valid values are left, right, center, multiline, and 
flip depending on the type of widget you are creating. 

 func 
Indicates whether the widget will be dynamic or static.  These are the only valid 
values for this attribute. 

 locx 
The x coordinate of the control on the wizard page. The value of this field is 
automatically changed when you move the control using your mouse. 

 locy 
The y coordinate of the control on the wizard page. The value of this field is 
automatically changed when you move the control using your mouse. 



Chapter 9 Wizards 
 

61 

 width 
The width of the control, in pixels. 

 height 
The height of the control, in pixels. 

 

 





Chapter 10 - Using the Data Interface Tool 
 

63 

Chapter 10 - Using the Data Interface 
Tool 
The data interface tool is used to specify the data import files from which measure data will be 
loaded. 

Working with the Data Interface Manager 
 
To specify where measure data is loaded from: 

1. Click New Measure. Only realized measures that have databases configured for them in the 
measure tool and are displayed. 

2. Select the desired measure and click OK. 

3. If the measure load intersection is different from the measure base intersection, click on the 
Load Intersection field and select appropriate dimensions using the list boxes. Only those 
dimensions that are at the same level as the base intersection or below will be displayed for 
the load intersection. 

4. Enter the file name from which data for the measure will be loaded. The file name defaults to 
the measure name, but can be changed. 

5. Enter the file start position for the measure data. The start position is automatically calculated 
for the user. The start position is calculated by adding the width of the dimensions of the load 
intersection +1. The width of the dimensions is configured in the Hierarchy Dimension Tool. 

6. Enter the file column width for the measure data. The column width defaults to 8, but can be 
changed. 

7. Enter the loadagg type for the measure data. 
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Chapter 11- Configuration Utilities 
Overview 
The following utilities are stand-alone utilities that can be run externally or from within the 
Configuration Tools.  The utilities provided include the Configuration Converter, Measure 
Extractor, Rule Extractor and the Function Library Manager, which are described in detail below. 
These utilities can be accessed from within the Configuration Tools in the Utilities pull down 
menu or from the Configuration Tools Utilities directory in Windows Explorer. 

Configuration Converter 
The Configuration Converter allows you to convert or upgrade a configuration that was originally 
created and saved in a prior release of the Configuration Tools. The Configuration Converter can 
either be used from the Utilities menu within the Configuration Tools or from the Configuration 
Tools build directory.  In the subdirectory there is a file called Converter.bat, opening this file 
will allow the Configuration Converter to be run. You must specify a new directory to which the 
newly converted configuration will be saved. The converter automatically updates the 
configuration to a more recent release of the Tools. 

Measure Extractor 
As its name suggests, the Measure Extractor can be used to extract all measure information within 
the configuration to a flat file. Upon running this utility, the user is prompted to load a 
configuration and select the project and solution within the configuration.  A file is then created 
in the root directory of the configuration called measout.txt. This file contains all of the measures 
and their properties within that solution. The first line of the file is the names of all of the measure 
properties. Thereafter, each measure is listed one to a line, with the properties separated by 
commas. 

The Measure Extractor can be accessed either from the utilities menu or from the Configuration 
Tools build directory. In the utilities subdirectory, there is a file called Measure Extractor.bat. The 
Measure Extractor can be run by double-clicking on the file. 

Rule Extractor 
As its name suggests, the Rule Extractor can be used to extract the rules in the configuration, for 
all rule sets and rule groups within a solution, to a flat file. The Rule Extractor functions similar 
to the Measure Extractor.  Upon running this utility, the user is prompted to load a configuration 
and select the project and solution within the configuration.  A file contains a listing of the rules 
within that solution, one expression per line, not necessarily one rule. The format of each line 
within the rule file is the name of the ruleset, the rule group, the rule, and finally the expression, 
separated by commas. 

The Rule extractor can either be selected from the Utilities menu or from the Configuration Tools 
build directory. In the utilities subdirectory, there is a file called the Rule Extractor.bat.  The Rule 
Extractor can be run by double-clicking on this file. 
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Function Library Manager 
The Function Library Manager is used to allow custom functions to be validated within the 
Configuration Tools.  The Function Library Manager can either be selected from the Utilities 
menu or from the Configuration Tools build directory. In the utilities subdirectory there is a 
file called Function Library Manager.bat. The Function Library Manager can be run by 
double clicking on this file. 

Once the Utility is run, click on the Add button to specify a function library.  Enter the name 
of the library, such as Forecast, without the .dll or .so extension. Click on the Accept button. 
Close the utility. The custom function will now be validated when used in a rule inside the 
Rule Tool. This custom function must exist in the /applib directory of your RPAS_HOME 
variable settings. If necessary, you can also use this utility to remove custom function 
libraries. 



Chapter 12- Building an RPAS domain 
 

67 

Chapter 12 - Building an RPAS domain 
 Overview 
This chapter provides detailed instructions for how to create an RPAS 11 domain using an 
existing configuration created using the configuration tools. 

Because building an RPAS domain is currently a manual process, the person building the domain 
should be skilled in administering UNIX or NT servers and should have scripting skills. 

This chapter contains the following sections: 

 Prerequisites 

 Client-side procedures 

 Server-side procedures 

 Loading measure data 

Prerequisites 
The following prerequisites are required before beginning the domain build process: 

 Installation of RPAS on your server. Refer to the RPAS 11.1Installation Guide for more 
information. 

 Installation of the Configuration Tools on your server. Refer to the RPAS 11.1 Installation 
Guide for more information. 

 Pre-existing configuration built using the Configuration Tools. 

Client-side procedures 
This section contains the following procedures: 

1. Create the Configuration 

2. Zip up the Configuration folder 

Create the Configuration 
To begin the domain build process, you need to start with a configuration that was built using the 
Configuration Tools. You can use a purchased configuration or create a new one with your 
specific hierarchies and measures. If you are creating a new configuration, be sure to note the 
path where your configuration is saved on your local disk. Once you have your configuration 
ready, continue with the following steps to build the domain. 
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 Note: In your configuration, if you create a measure that requires a database, you need to 
specify the database as data/dbname. If you do not specify the data part of the path, 
then the measure database will be built directly under the domain root. 

Zip up the Configuration folder 
1. Find the location where you saved your configuration. 

2. Using Windows Explorer, go to the path of the configuration. 

3. Right-mouse click on the Configuration folder, and select Add to Zip.  You should zip up the 
entire contents of the Configuration beginning with the Configuration root folder such that 
the zip file will include the Project(s) and Solution(s).  It is important that you zip up the 
entire Configuration for the entire directory structure and not just the specific .xml files.  Do 
not change the name of the configuration folder or alter the contents of the folder in any way 

In the example below, you should click on TPGA to highlight the folder, then right-
mouse click and select Add to TPGA.zip. 

 Configurations        (directory for all configurations)   

       TPGA       (Configuration Name directory) 

       TP       (Project directory) 

TPGA.xml  (Configuration .xml file) 

4. Using FTP, transfer the <Configuration>.zip file over to the server in binary mode.  You can 
place it in your home directory for now. 

Server-side procedures 

 Note: The configuration tools are supported on all platforms (Sun, HPUX, AIX, and NT); 
however, they require Java v1.4 or higher. Make sure that the server you will be using 
has this version of Java. 

This section contains the following procedures: 

1. Unzip the configuration file 

2. Verify the environment variable settings 

3. Get the input files ready 

4. Build the domain 
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Unzip the configuration file 
1. Find the location where you want to put your configuration file. 

 Note: Always put a newly changed configuration in a new directory path. Do not 
overwrite an existing configuration. 

2. Move the <Configuration>.zip file to this location. 

3. Unzip the <Configuration>.zip file using the UNIX command:   
unzip –a <Configuration>.zip 

4.   Do not change the directory name for the configuration or alter the contents in any way.  

Verify the environment variable settings 
Prior to beginning this step, you should have installed RPAS and the Configuration Tools on your 
server.  During that process, you should have set up the necessary environment variables for 
RPAS and the Configuration Tools.  Refer to the RPAS 11.1 Installation Guide if the 
environment variables below have not been set up. 

Log into the server. Use the commands below to verify your environment settings: 
echo $RPAS_HOME 

echo $RIDE_HOME 

echo $JAVA_HOME 

echo $PATH 

 Note: The path for the RPAS_HOME variable changes with each new RPAS release. 

If you make any changes to the environment variable settings, remember to exit and restart your 
UNIX session in order to execute your .profile and make the changes effective. This step is very 
important before you continue to the remaining steps. 

Get the input files ready 
1. Designate a directory for the location of your input files, and move your files into this 

directory.  

 As a recommendation, Retek Services has used the directory name to_rpas as a standard 
for the location of input files. At a minimum, the hierarchy files (product, location, and 
calendar hierarchy files) are needed to build the domain. At this time, a calendar file must 
be loaded.  
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2. If necessary, rename the hierarchy files to prod.dat, loc.dat, and clnd.dat. These file 
names are required. The format of these files must match the hierarchy configuration 
specified using the configuration tools.   

Build the domain 
1. Run the rpasInstall script to build the domain. This executable is located in the path to 

$RIDE_HOME/bin. The syntax for the rpasInstall script is as follows:   
rpasInstall [-version | -testinstall | -fullinstall | -
patchinstall] –cn <config_name> –ch <config_home> –dh 
<domain_home> –in <input_directory> [-rf <function_name>]  
–log <logfile_name> 

Required: 

[-fullinstall | -patchinstall | -testinstall] : the type of installation to be performed 

where: 

-fullinstall - builds a full domain and loads the hierarchy data files 

-patch install - patches an existing domain. Updates or unregisters/registers 
measures as necessary that have changed 

-testinstall - used for testing only, Only generates configuration files. 

 ch <config_home> : where <config_home> is path to the directory containing 
the configuration 

-cn <config_name> : where <config_name> is name of configuration 

-in <input_home>  : where <input_home> is the directory containing the  input 
files for the domain to be created 

-log <log_name>   : where <log_name> is the name of the log file to be created 
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Optional: 

  -v-version: Provides the version number of the Tool build as it relates to the 
release or patch number. 

-rf <function_name> : where <function_name> is the filename of the function 
to be registered.  This pairing may be repeated for multiple functions 

Conditional: 

-configdir <config_directory>: where <config_directory> is the path to the 
directory containing the xml files used by RPAS. This is a required argument if 
the user wants to supply globaldomainconfig.xml or calendar.xml 

-dh <domain_home> : where <domain_home> is path to directory in which 

the domain will be created, not including the root of the domain.  This is a 
required option if and only if globaldomainconfig.xml is not used.   

-p <dim_name>: where <dim_name> is the partitioning dimension - use if and 
only if global domain is being implemented without the use of 
globaldomainconfig.xml. 

 Note: When building a domain for the first time, in addition to the directory for the 
domain, an installs directory gets created at the same level as the domain itself. The 
installs directory is essential for the patch process, so you should not move or rename this 
directory. 
 
When sending in an issue to Retek Customer Care, if asked to provide a domain, please 
be sure to also provide the installs directory with it. For completeness, you should 
provide the following items in order to help Customer Care better diagnose the issue: 
  

• The configuration 

• The script used to run the rpasInstall script 

• The domain 

• The install directory 

• The log output file 

RPAS Install options 

 Note: The –testinstall, -fullinstall, and –patchinstall options are all optional parameters, 
although one of them must be specified for the rpasInstall command. 
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–testinstall 

The –testinstall option should only be used for a new domain. It only generates the configuration 
files, meaning it creates the domain shell with only the repos and setup directory. Because it does 
not build out the domain, it runs very fast. Within the setup directory, the configuration will be 
converted into the init_hparm.mspl file, which is a text version of the long-used standard 
procedure asetup.init_hparm, to be loaded into the domain. 

–fullinstall 

The –fullinstall option will build a pristine domain with only the hierarchy input files. It does not 
load measure data. 

–patchinstall 

The –patchinstall option will update the measure properties that are indeed updateable without 
impacting any previously loaded data.   

 Warning: For those measure properties that are NOT updateable, the  
–patchinstall option will unregister the measure and re-register it, thus losing any 
previously loaded data.  Please refer to the list of measure properties in the Applying 
Patches section as to which measure properties are updateable and which ones are not. 
The Configuration Tools will allow you to update all of the properties, but the Installer 
will determine whether the measure must be unregistered,  and if  the property is 
updateable. The patchinstall option will not rebuild the domain. Please be aware that if 
you change a non-updateable measure property, the measure will be unregistered and , all 
data that has been stored for that measure will be permanently deleted from the domain. 
Any data for that measure will have to be re-loaded into the domain. 

–cn config_name 

The –cn config_name option is used to specify the name of the configuration (without the .xml 
extension) that you specified in the Configuration Tools. This is also known as the root directory 
for the configuration. So, in the example above, the name of the configuration is TPGA. For this 
option, you should not specify the path leading up to configuration directory name as that is 
specified using the –ch config_home option. The –cn config_name option is required. 

–ch config_home 

The –ch config_home option is used to specify the full directory path leading up to the 
configuration name. Do not include the configuration name as part of this option. This is the path 
that contains your configuration located on the server where you unzipped it, not including the 
configuration directory name. The –ch config_home option is required.   
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–dh domain_home 

The –dh domain_home option is used to specify the directory path where the domain(s) will be 
built. This directory MUST already exist.  Therefore, you must manually create it. Within the 
domain_home path, a directory will be created with the name of the configuration, and then 
within that directory, a subdirectory will be created for each Project. You do not specify the name 
of the domain root as it will use the name of the Project that you specified in the Configuration 
Tool to be the name of the domain root. The –dh domain_home option is required. We 
recommend that you do not assign the domain home path to be the same path as your 
configuration home.  You should use a different directory path for the domain home for better 
organization of files. 

–in input directory 

The –in option designates the location of the input_directory, which is the directory path that 
contains the hierarchy files to load or the measure registration file. The –test option should not be 
specified if the input_directory parameter is specified. The –in input_directoy option is required if 
the –fullinstall option is used. Otherwise, it is optional. 

–rf register_function 

The –rf register_function option is used to specify the name of the function that you want to 
register. This option should be used to register a shared object file that is located in the 
RPAS_HOME/applib directory and is not automatically validated by the RPAS JNI file. 
Currently, the Forecast procedure must be registered using this option if it is used in a rule within 
the configuration. When you specify the function name with this option, do not include the lib or 
.so part of the function name. The –rf option is an optional parameter. 

-log logfilename 

The –log option designates the path and logfile_name that will contain output from the domain 
creation process. The logfile will be located in the directory from where the Installer is initiated, 
meaning the present working directory, if a path is not specified. There will be output from the 
Installer in the window from where the process is initiated. You can use the UNIX command:  
tail –f logfile to view the logfile as the process is executing. 

-configdir configfiles_directory 

The –configdir option is different than the –ch config_home option,  Where the –ch config_home 
directory is the path to the configuration, the –configdir option is the path to only the custom 
configuration files, globaldomainconfig.xml, used for a global domain environment, or a 
calendar.xml file.  If neither of these files are being used, then this option is not needed and 
should not be specified as part of the call to rpasInstall. 

-p dimname 
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The –p option is only necessary if the configuration is being used to build a global domain 
environment that is partitioned by a dimension, such as department.  The actual RPAS name for 
the dimension should be specified as the argument, such as dept, without quotation marks.  If a 
globaldomainconfig.xml file is being used to create the global domain environment, then this 
option is not needed and should not be specified as part of the call to rpasInstall.  Either the –
configdir or the –p option should be specified for setting up a global domain environment, but 
both should not be used together as part of the call to rpasInstall.  If both are specified, then the 
configdir option will take precedence and the –p option will be ignored. 

At a high-level, the rpasInstall script performs the following functionality automatically: 

 Creates a “pristine” domain or shell domain without any data or hierarchy files loaded – only 
contains source and application extension code 

 Builds the hparm configuration file  

 Builds the measure configuration file 

 Builds the rule configuration file 

 Executes abatch.create, which loads in hierarchy files 

 Registers measures, rules, and templates 

 Note: The rpasInstall script only loads the hierarchy files and builds the domain. It does 
not load any measure data. The hierarchy files are copied to the /input/processed 
directory of the domain and appended with a time-date stamp. 

You should execute this script in the path where your configuration is located (see Step 1 above). 
For ease of execution, we recommend creating a script to execute the rpasInstall command. 
Remember to change the permissions of the file to executable permissions (such as, 755). We 
recommend that you add lines before and after the rpasInstall call to set the usermode to single 
for better domain build performance. 

Below are some example scripts, for the rpasInstall command. 

 createDomain.sh: 
export USERMODE=SINGLE 

rpasInstall –fullinstall -cn TopPlan –ch /test/Config  
-dh /test/domains –in /test/to_rpas –log rpasInstall.log 

export USERMODE= 

createGlobalDomainConfig.sh: 
export USERMODE=SINGLE 
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rpasInstall –fullinstall -cn TopPlan –ch /test/Config –in 
/test/to_rpas –configdir /test/globalconfigfile –log rpasInstall.log 

export USERMODE= 

createGlobalDomainDim.sh: 
export USERMODE=SINGLE 

rpasInstall –fullinstall -cn TopPlan –ch /test/Config –in 
/test/to_rpas –configdir /test/globalconfigfile –log rpasInstall.log 
–p dept 

export USERMODE= 

 During the domain build or patch process, a directory called tmpConfig will get created 
at the same level as the installs directory.  Do NOT remove this directory during the 
execution of the process nor at the end of the process.  The tmpConfig directory will 
contain a converted hierarchy.xml file used in the domain building process.  

• For NT: If you are building a domain on NT, then in your script to run the Installer, you need 
to use forward slashes '/' in all of the paths used in the parameters. 

• The paths for your RIDE-HOME and RPAS_HOME variables cannot have spaces in them. 
Give this restriction, Do NOT place your Tools build, your configurations, or RPAS 
installation under Program Files or My Documents. 

Validate Domain Build Results 
Once the domain build process finishes, you should check the logfile to verify that the process 
executed successfully.  You should search for the words ERROR, FAILURE and exception 
inside the logfile.  The end of the logfile should look similar to the output below: 
Time: 58.451 

COMPLETE 
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Applying Patches to a Domain 
In order to patch your domain with changes to your configuration, use the -patchinstall option 
when running the Installer. Prior to the beginning the patchinstall process, we recommend that 
users commit their workbooks as needed, and a backup copy of the domain is made. 

As well, before beginning the process, verify that you are using the patchinstall option in the 
rpasInstall command instead of the -fullinstall option.  You should only change the fullinstall 
option to patchinstall inside your call to rpasInstall. You should not change any other options in 
the rpasInstall call when running a patchinstall. 

Currently, the patchinstall operation does not update any hierarchy or dimension changes in your 
configuration, with the exception of user defined dimensions.  This includes not being able to 
patch changes to the hierarchy purge age, the security dimension, and the multi-language flag 
inside the Workbench. 

 If you need to update the hierarchy purge age inside your existing domain, you can use 
the loadHier RPAS utility in batch mode to override the current settings. Please refer to 
the RPAS Administrative Guide for further details regarding the usage of the loadHier 
utility. 

The patchinstall operation does allow for changes to some of the measure properties as indicated 
in the table below. As well, the patchinstall operation allows for changes to rule sets, rule groups, 
and workbook templates.  During the process, the rule sets, rule groups, rules, and workbook 
templates are completely rebuilt. 
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Patching Measure Properties 
The following table indicates those measure properties that can be updated via the patch 
process and those that will require the measure to be unregistered and reregistered. 
 

Property Description Updateable 

Label Label of measure. Defaults to measure name.  Unique name 
of measure for display in client (in grid and measure 
dialogs). In the past, labels were sometimes non-unique. 
There is no maximum size limit, but you should keep grid 
display limitations in mind when creating a measure label. 
(History: displayed in wb but not in measure dialogs.) 

Updateable 

Description Potentially long, descriptive summary of measure Updateable 

Data Type Base types: int, real, string, date, boolean. The numeric 
representations of these types are 1,2,3,4 and 6 respectively. 
Note; This is a required property for adding a measure. 

Not 
updateable 

Na Value Suggested value for unpopulated (na) cells. Defaults 
according to type. Initially, the base array of a measure is 
defined with this naval: however, this is subject to change in 
order to optimize the compression factor. 

Not 
updateable 

Base 
Intersection 

Base intersection for measure. Concatenation of all 
dimension names (4 characters, suffixed by' ' as necessary). 
Dimensions are ordered according to the hierarchy to which 
they belong.  In [Measure] SFX array, baseint is prefixed 
by"I". Simply 'I' for scalar measures. 
Note: This is required property for adding a measure. 

Not 
updateable 

Agg 
Method 
(defagg) 

Default aggregation method (see Rule Functions document 
for master list) 
Note that changes to defagg will only be reflected in new or 
rebuilt books. 

Updateable 
unless set to 
recalc 

Spread 
Method 
(defspread) 

Default spread method 
Note that changes to defagg will only be reflected in new or 
rebuilt workbooks. 

Updateable 
unless set to 
recalc 

Base State Editable at base level:read, write, Default to read Updateable 
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Property Description Updateable 

Agg State Editable at base level: read, write, 
Default to read 

Updateable 
 

Database Database where measure is stored in domain (in future, a 
partitioned database which comprises many partitions). 
If database is NA then measure is not stored, it specifies the 
relative path from domain root.Syntax is as "data/test". 

Not 
Updateable 
 

Viewtype Indicates if the measure is calculated when viewed.  
If the type is not 'none' then the measure must not be 
materialized ( not stored in workbook or domain) and must 
appear on the LHS of one and only one expression in a rule ( 
the view expression). Synchronized view types are 
maintained immediately at cell edit time. View types (and 
their corresponding integer values) include: 
none (0) - measure is stored 
view only (1) - measure is calculated when viewed (aggstate 
and basestate must be read only). 
sync_first_lag (2)-period 1 from first measure (no calendar), 
periods 2..N fromsecond measure 1..N-1(lag)[such as.bop 

  os &eop] 
syn_lead_last (3)- periods 1..N-1 from first measure 2..N 
(lead), period N second measure (no calendar) {such as.eop 

 bop & cs} 
sync-first (4) - get period 1 from measure (similar to first 
agg type along calendar dimension) [such as os   bop] 
sync-last (5) - get period N from measure (equivalent to last 
agg type along calendar dimension) [such as. cs   eop] 

Updateable 

Sync With Comma separated list of measures used for synchronization. 
Depends on view type. 

Updateable 

Insertable Indicates whether measure is visible to user for inclusion in 
workbooks (used in addition to measure security). Default to 
true. 

Updateable 

UI Type Indicates whether the measure is a picklist Updateable 

Range Specify suitable range for the measure at edit time. For Updateable 
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Property Description Updateable 

picklist measures (indicated with ui-type property) these are 
the displayed/possible values. 
For numeric values, the syntac is as Lower Bound: Upper 
Bound. 
For strings, it is the maximum length. 
For picklist measures (both numeric and string) values can 
be explicitly listed as "a,b,c,d...", additionally labels can be 
specified for each value such as "valuea(labela),, 
valueb(labelb),..."where the labels will be displayed in the 
user interface. 

Purge Age Limits the history of data in a measure along the time 
dimension (purge occurs during load measure process). 
Default to na 

Updateable 

Refreshable No longer used in the 11.x RPAS architecture. The refresh 
rule group is used to determine what measures are refreshed. 

Not 
applicable 

materialized  This property is not viewable or updateable within the 
Tools Workbench.  There are two possible values for 
materialized: 
Persistent: a "normal" measure 
Display: a measure that is only calculated when it is 
displayed (e.g. in the client). Only the displayed values are 
calculated, rather than the whole measure, which 
significantly improve performance with these measure. 
Display-only measures have three major restrictions: 
1. Must have agg type "recalc" 
2. Cannot appear on the RHS of any rule 
3.  Cannot be edited. 

Not 
updateable 

Lower 
Bound 

A measure that provides minimum bounding values for this 
measure's data cells. 

Not 
updateable 

Upper Bound A measure that provides maximum bounding values for this 
measure's data cells. 

Not 
updateable 

Special 
Value Type 

Indicates the different types that are allowed for the special 
value functionality 

Updateable 
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Property Description Updateable 

Special 
Value 

The value for the special value when the type is specified 
as user-entered 

Updateable 

Dimension 
Attribute 

Indicates that the measure is a dimension attribute measure 
of which certain qualifications must be met. 

Updateable 

Dimension 
Attribute 
Name 

Indicates the name of the dimension attribute measure Updateable 

Dimension 
Attribute 
Label 

Indicates the label of the dimension attribute measure Updateable 

Allowed 
Aggs 
 
 

The allowed aggregation methods depending on the data 
type of the measure.  This property displays a multi-select 
checkbox dialog box in the Tools, containing values such 
as total, average, min, max, etc… 

Updateable 

 Notes 

• When a recalc measure is registered, its aggstate and basestate are set to userspecified value 
no matter what is specified for defspread field. 

• When a measure with defagg "Popcount" or "NobCount' is registered, this measure's 
defspread is set to NONE, aggstate is set to read-only no matter what user specifies for this 
field. 

• For measures that don't fit into the above descriptions, if their defspread is NONE, their 
aggstate is read-only all the time. 

Measure Loading Properties 

Property Description Updateable 

Load 
Intersection 

Intersection at which measure is loaded (for ovr, inc 
loads). 
Defaults to the baseintersection.  The load 
intersection can only be specified at or below the 
base intersection. 

Not Updateable 

File Name File used to load measure (suffix or ovr, inc., clr). Updateable 
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Defaults to the measure name. 

Start Position Start column of data (defaults to column after 
dimensions). 

Updateable 

Column Width Width of data (defaults by type). 
Note: For Boolean types, width can be >=1, but only 
the first character is read. 

Updateable 

Load 
Aggregation 
Method 

The aggregation method used when aggregating the 
data from the load intersection to the base 
intersection.  

Updateable 

Loading measure data 

 Note: This step is optional. If you have already purchased a solution template that 
contains a script to load data, you can skip this section and proceed with the installation 
process of your solution template. 

Below is the process to load measure data. 

During the initial domain build process, all of the hierarchy and measure data files in your input 
home directory will be copied to the input directory domain. If necessary move or copy any new 
measure data files to the input directory of the domain. The measure data file must have a valid 
measure filename, such as xxx.ovr, xxx.rpl, xxx.inc, or xxx.clr, where xxx is the measure name. 

Use the loadmeasure utility to load your data. Loadmeasure should be in your path, meaning that 
you can run it from any directory. The syntax for loadmeasure is as follows:   

loadmeasure –d domainPath –m measName (–l | –a) {–u 
user:password} 

where : 

–d domainPath 
Specifies the domain in which to load the measure. 

–m measName 
Specifies the name of the measure to load. The name should be lowercase. 

–l 
Use this argument to load the named measure. 

–a 
Use this argument to apply any staged loads for the named measure. 
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–u user:password 
Specifies an Acumate user and password. If –u is not specified, adm is used. 

The loadmeasure utility must be used for each measure for which you want to load 
data. It is recommended to redirect the output to a log file. 

For example: 
loadmeasure -d /domains/D01 -m rsal -l > /domains/logs/rsal.log.d01 & 

After building the domain 
After building the domain and loading measure data, the next steps are as follows: 

 Use the RPAS Configure utility to denote the location of the domain on the server and 
designate a DomainDaemon port number. See The Configure utility in Chapter 11. 

 Execute a DomainDaemon process with the port number specified in the Configure utility. 
Refer to the RPAS 11.1 Administrator’s Guide for instructions on executing the 
DomainDaemon. 

View the domain using the RPAS client. Set up the appropriate permissions on the measures in 
the domain using the Measure Administration workbook and then view the measures by building 
a Measure Analysis workbook. Refer to the RPAS 11.1 Administrator’s Guide for instructions on 
using these workbooks. 

Applying a New Tools Build Patch Release 
When there is a new release of the RPAS Configuration Tools, you will need to replace 
the entire Tools directory with the new release. We recommend that you make a backup 
copy of your pre-existing configuration before using it with the new Tools release. We 
also recommend that you create a new directory for the new Tools release rather than 
overlaying the old release. Remember to update your RIDE_HOME environment 
variable as needed to point to the new Tools release.  Refer to the RPAS Installation 
Guide for more details. 
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Appendix A - Global Domain 
The following points should be noted when configuring and setting up a global domain 
environment. 

• When creating a new global domain configuration file, globaldomainconfig.xml, reference 
the RPAS example of the configuration file, globaldomainconfig_example.xml, located in the 
%RPAS_HOME%/domain/config_examples directory of the RPAS installation to use as a 
guide in building this file.  Once this file is created, put it in the configdir directory path (as 
specified using the –configdir option in the Installer). 

• In the globaldomainconfig.xml file, in the path, the user needs to specify the entire path to the 
master domain, including the root name of the master domain.  The path leading up to the 
root of the master domain must exist; however, the master domain root directory must not 
exist at the beginning of the domain build process. 

• Not all of the options for createGlobalDomain are supported via the Installer.  The Installer 
does not support the –a posGrouping, -f, -s setupDir, -version options.  For the posGroupings 
primarily, if specific groupings are necessary, then the user will need to specify them in the 
configuration file, globaldomainconfig.xml, for them to be used for global domain. 

• Even though createGlobalDomain and createRpasDomain can accept a calendar configuration 
file, it is not required (and should not be used) unless you would like to use the RPAS 
calendar generator.  The Configuration Tools still contains the calendar hierarchy structure 
within the hierarchy.xml configuration file. 

• The master global domain will contain a directory called config, which will house the 
globaldomainconfig.xml file.  You should not delete this directory or file. 

• You should not delete the tmp directory under the domain home directory while the domain 
build process is taking place. 

• Within the Tools Workbench, there is no validation for the baseintersections of the measures 
in comparison to the partitioning dimension.  During the domain build process, RPAS will be 
responsible for determining if measure data will be stored in the master global domain or the 
local domains. 

• To configure the global domain functionality, the user can provide a globaldomainconfig.xml 
file that specifies how each of the local domains should be partitioned based on position 
groupings.  If a globaldomainconfig.xml file is not provided and just the partitioning 
dimension is provided, then a local domain will be built for each position within the 
partitioning dimension (e.g. If a company has 5 departments, and the partitioning dimension 
is department, then there will be 5 local domains and 1 master global domain.)    

• There are new conditional parameters that are used by the Installer for configuring and setting 
up a global domain environment as below: 

-dh <domain_home> : where <domain_home> is the path to the directory in which the 
domain will be created 

Non-Global Domain – required 

Global Domain (w/ globaldomainconfig.xml) - ignored 

-configdir <config_directory> : where <config_name> is the path to the configuration 
xml files, including globaldomainconfig.xml, hierarchy.xml, and calendar.xml 
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Non-Global Domain – optional, but required if using a calendar.xml file 

Global Domain (w/ globaldomainconfig.xml) - required 

Global Domain (w/o globaldomainconfig.xml) - optional, but required if using a 
calendar.xml file 

–p <dim_name>:  where <dim_name> is the partitioning dimension.  Only valid if the 
configuration has been marked as a global domain configuration with the Properties 
dialog box.  If the configdir option is specified and a globaldomainconfig.xml file is 
found there, then the –p option will be ignored and the partitioning dimension that is 
specified within the globaldomainconfig.xml file will be used instead.  

Non-Global Domain – ignored 

Global Domain (w/ globaldomainconfig.xml) - ignored 

Global Domain (w/o globaldomainconfig.xml) - required 

• For patching a Global Domain implementation, you can change measures, rules, and 
workbook templates, and the master domain and local domains will be patched accordingly. 
However, you cannot turn a non-global domain implementation into a global-domain 
implementation and likewise, vice versa.  The Global Domain flag in the configuration is 
ignored during the patch process, so even if you change its status, the construction of the 
implementation will not change.   

• When patching either a Global Domain implementation or a regular, stand-alone, single 
domain, in the call to the Installer (rpasInstall), it is imperative that you do not change any of 
the parameters that were used during the original domain build.  The only parameter that you 
should change is fullinstall to patchinstall.  The other parameters need to remain unchanged. 
 We recommend using a script for the rpasInstall call so that it is easier to just change the 
fullinstall parameter to patchinstall while leaving the other parameters in their original state. 

 



Appendix B– Hypersparse 
 

85 

Appendix B - Hypersparse 
A configuration can be setup initially with the intent that the domain will be created as 
hypersparse by clicking the box in the Workspace Properties dialog box.  Otherwise, the domain 
will be built normally as sparse.  The hypersparse flag can be set when the configuration is first 
created or afterwards via the Workspace Properties dialog box. 

For the patch process, for a previously existing sparse domain, if the hypersparse flag is checked 
in the configuration and the patch process is run, then the domain will be automatically converted 
to hypersparse. 

Similarly, vice versa, for a previously existing hypersparse domain, if the hypersparse flag is 
unchecked, then during the patch process, RPAS will attempt to convert the domain to sparse. 
 This process may not succeed if the size of the domain is still beyond the sparse limitations, so 
we strongly recommend that you make a backup of the domain before running the patch process. 
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Appendix C - Glossary 
configuration 

A configuration represents the overall workspace for an RPAS implementation. For example, a 
configuration could represent a company or a division. 

dimension 

Levels of a hierarchy, such as day, week, month, year for a calendar hierarchy.  

expression 

Expressions are the basis of all calculations of the relationships between measures, and are 
evaluated by the calculation engine during a calculation. Expressions are written in a syntax that 
allows for the calculation of a single measure from other measures, constants and parameters, 
using standard arithmetical functions and a rich set of mathematical, technical and business 
functions. Expressions are therefore an algorithmic statement of a relationship between measures.  

hierarchy 

Hierarchies are the structures used by an organization to describe the relationships that exist 
between the many dimensions. For each project, the following hierarchies are automatically 
created: Calendar, Product, Location, and Measure. 

major component 

A major component specifies the default measure property information that is inherited by all 
minor components. Ultimately, this property information is inherited by the measures that are 
generated from the component structure. 

measure 

Any item of data that can be represented on a grid in a worksheet.  

measure profile 

The worksheet-specific set of viewable measures  

minor component 

A minor component inherits measure property information from the major component to which it 
belongs. Property information can also be modified at this level. Measures generated from these 
components inherit the property information defined for the minor component. 

project 

A project within a configuration represents an RPAS domain. For example, configuration XYZ 
could contain a Planning project or Forecasting projects. 

realize 

When a measure is auto-generated by the Measure Tool, it is considered a prototype measure and 
cannot be edited or used in any other configuration component. To enable the measure to be 
edited and/or used elsewhere in the configuration, it must be realized first. 



Retek Predictive Application Server 
 

88 

rule 

Rules are collections of expressions that describe the same relationship between measures, but 
that solve for different measures. All the expressions in a rule must use the same measures, and 
must have a different target measure (the measure on the left hand side of the expression that is 
calculated by the expression). 

See expression. 

rule group 

A rule group is a collection of rules that are treated as a unit by the calculation engine, with the 
integrity of all the rules in the rule group being maintained together. The calculation engine 
always has one (and only one) active rule group. 

rule set 

A collection of rule groups, each of which is used by the calculation engine for a specific 
purpose. By default, each rule set contains the following rule groups: load, calculate, refresh and 
commit. 

solution 

A solution corresponds to an application configuration within an RPAS domain. For example, 
project XYZ could contain Retek Item Planning and Retek Merchandise Financial Planning 
solutions. 

wizard 

A wizard is a feature that steps the user through the process of building a new workbook from a 
template. A wizard displays successive dialogs that require the user to answer a sequence of 
questions or enter selections regarding the content of the workbook. Responses to these questions 
are used to automatically format and populate the workbook. 

workbook 

A workbook is the easily viewed, easily manipulated multidimensional framework used to 
perform specific business functions such as generating trading information and reviewing 
availability data.  

workbook tab 

A workbook tab is a major subdivision of a workbook. A workbook contains one or more 
workbook tabs. 

worksheet 

Worksheets are multidimensional spreadsheets used to display workbook-specific information. 
Workbooks can include one or many worksheets. Worksheets can present data in the form of 
numbers in a grid, or these numeric data values can be easily converted to a graphical chart. 
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